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Class schedule

Date Time Location

Mon, Aug. 18 1:00 PM - 5:30 PM RLP 2.606
Tue, Aug. 19 1:00 PM - 5:30 PM RLP 2.606
Wed, Aug. 20 9:00 AM - 12:00 PM RLP 1.302D

1:00 PM - 4:30 PM BAT 5.108
Thu, Aug. 21 9:00 AM - 12:00 PM RLP 3.106

1:00 AM - 4:30 PM RLP 3.106

We’ll take short breaks periodically during the morning and afternoon sessions as needed.

Description

Welcome to Introduction to Methods for Political Science, aka “Methods Camp”! Methods
Camp is designed to give everyone a chance to brush up on some skills in preparation for the
introductory Statistics and Formal Theory courses. The other goal of Methods Camp is to
allow you to get to know your cohort. We hope that matrix algebra and the chain rule will
still prove to be good bonding exercises!

As you can see from the above schedule, we’ll be meeting on Monday, August 18th, through
Thursday, August 21st. Classes at UT begin the start of the following week on Monday, August
25th. Below is a tentative schedule outlining what will be covered in the class, although we
may rearrange things if we find we’re going too slowly or too quickly through the material.

Course outline

1 Monday afternoon: Intro to R

• Introductions
• R and RStudio: basics
• Objects (vectors, matrices, data frames, etc.)
• Basic functions (mean(), length(), etc.)

6
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• Packages: installation and loading (including the tidyverse)

2 Monday afternoon: Tidy data analysis I

• Tidy data
• Data wrangling with dplyr
• Data visualization basics with ggplot2

3 Tuesday morning: Functions

• Definitions
• Functions in R
• Common types of functions
• Logarithms and exponents
• Composite functions

4 Tuesday afternoon: Calculus

• Derivatives
• Optimization
• Integrals

5 Wednesday morning: Tidy data analysis II

• Loading data in different formats (.csv, R, Excel, Stata, SPSS)
• Recoding values (if_else(), case_when())
• Handling missing values
• Pivoting data
• Merging data
• Plotting extensions (trend graphs, facets, customization)

6 Wednesday afternoon: Probability

• Probability: basic concepts
• Random variables, probability distributions, and their properties
• Common probability distributions

7 Thursday morning: Statistics and simulations

• Statistics: basic concepts
• Random sampling and loops in R
• Simulation example: bootstrapping

8 Thursday afternoon: Matrices

• Matrices
• Systems of linear equations
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• Matrix operations (multiplication, transpose, inverse, determinant)
• Solving systems of linear equations in matrix form (and why that’s cool)
• Introduction to OLS

9 Thursday afternoon: Wrap-up

• Project management fundamentals
• Self-study resources and materials
• Other software (Overleaf, Zotero, etc.)
• Methods resources at UT

Contact info

If you have any questions during or outside of the methods camp, you can contact us via email.
Or if you are curious about our research, you can also check out our respective websites and
Twitter accounts (or should we say X…):

• Meiying Xu: xu.meiying@utexas.edu
• Joel Yew: joel.yew@utexas.edu

Acknowledgements

We thank previous Methods Camp instructors for their accumulated experience and materials,
upon which we have based ours. UT Gov Prof. Max Goplerud gave us amazing feedback for
this iteration of Methods Camp (2025). All errors remain our own (and will hopefully be fixed
with your help!).

Materials from previous editions

• 2024: co-taught by Andrés Cruz and Meiying Xu.

• 2023: co-taught by Andrés Cruz and Matt Martin.
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Setup

Installing R and RStudio

R is a programming language optimized for statistics and data analysis. Most people use
R from RStudio, a graphical user interface (GUI) that includes a file pane, a graphics pane,
and other goodies. Both R and RStudio are open source, i.e., free as in beer and free as in
freedom!

Your first steps should be to install R and RStudio, in that order (if you have installed these
programs before, make sure that your versions are up-to-date—if they are not, simply follow
the instructions below to re-install them):

1. Download and install R from the official website, CRAN. Click on “Download R for
<Windows/MacOS>” and follow the instructions. If you have a Mac, make sure to select
the version appropriate for your system (Apple Silicon for newer M1/M2/M3 Macs and
Intel for older Macs).

2. Download and install RStudio from the official website. Scroll down and select the
installer for your operating system (most likely the .exe for Windows 10/11 or the .dmg
for macOS 12+).

After these two steps, you can open RStudio in your system, as you would with any program.
You should see something like this:

INFO Note for Windows users

While the installation steps above should be enough for most tasks, we also suggest that
Windows users install RTools (click on the “Rtools44 installer” link at the middle of the
package to get the .exe file). Rtools is needed on Windows to install some advanced
packages, so it is a good idea to have it on your system.

That’s it for the installation! We also strongly recommend that you change a couple of RStudio’s
default settings.1 You can change settings by clicking on Tools > Global Options in the
menubar. Here are our recommendations:

1The idea behind these settings (or at least the first two) is to force R to start from scratch with each new session.
No lingering objects from previous coding sessions avoid misunderstandings and help with reproducibility!
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Figure 1: How RStudio looks after a clean installation.
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• General > Uncheck "Restore .RData into workspace at startup"

• General > Save workspace to .RData on Exit > Select "Never"

• Code > Check "Use native pipe operator"

• Tools > Global Options > Appearance to change to a dark theme, if you want! Pros:
better for night sessions, hacker vibes…

Setting up for Methods Camp

All materials for Methods Camp are both on this website and available as RStudio projects for
you to execute locally. An RStudio project is simply a folder where one keeps scripts, datasets,
and other files needed for a data analysis project.

Below are RStudio projects for you to download, available as .zip compressed files. On MacOS,
the file will be uncompressed automatically. On Windows, you should do Right click >
Extract all.

• Download Part 1 of the class materials.
• Download Part 2 of the class materials.
• Download Part 3 of the class materials.
• Download Part 4 of the class materials.

Exclamation-Triangle Warning

Make sure to properly unzip the materials. Double-clicking the .zip file on most Windows
systems will not unzip the folder—you must do Right click > Extract all.

You should now have a folder called methodscamp_part1/ on your computer. Navigate to the
methodscamp_part1.Rproj file within it and open it. RStudio should open the project right
away. You should see methodscamp_part1 on the top-right of RStudio—this indicates that
you are working in our RStudio project.

Figure 2: How the bottom-right corner of RStudio looks after opening our project.

That’s all for setup! We can now start coding. After opening our RStudio project, we’ll begin
by opening the 01_r_intro.qmd file from the “Files” panel, in the bottom-right portion of
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RStudio. This is a Quarto document,2, which contains both code and explanations (you can
also read the materials in the next chapter of this website).

2Perhaps you have used R Markdown before. Quarto is the next iteration of R Markdown, and is both more
flexible and more powerful!
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1 Intro to R

In Quarto documents like this one, we can write comments by just using plain text. In contrast,
code needs to be within code blocks, like the one below. To execute a code block, you can
click on the little “Play” button or press Cmd/Ctrl + Shift + Enter when your keyboard is
hovering the code block.

2 + 2

[1] 4

That was our first R command, a simple math operation. Of course, we can also do more
complex arithmetic:

12345 ^ 2 / (200 + 25 - 6 * 2) # this is an inline comment, see the leading "#"

[1] 715488.4

In order to create a code block, you can press Cmd/Ctrl + Alt + i or click on the little green
“+C” icon on top of the script.

INFO Exercise

Create your own code block below and run a math operation.

1.1 Objects

A huge part of R is working with objects. Let’s see how they work:

my_object <- 10 # opt/alt + minus sign will make the arrow
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my_object # to print the value of an object, just call its name

[1] 10

We can now use this object in our operations:

2 ^ my_object

[1] 1024

Or even create another object out of it:

my_object2 <- my_object * 2

my_object2

[1] 20

You can delete objects with the rm() function (for “remove”):

rm(my_object2)

1.2 Vectors and functions

Objects can be of different types. One of the most useful ones is the vector, which holds a
series of values. To create one manually, we can use the c() function (for “combine”):

my_vector <- c(6, -11, my_object, 0, 20)

my_vector

[1] 6 -11 10 0 20

One can also define vectors by sequences:
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3:10

[1] 3 4 5 6 7 8 9 10

We can use square brackets to retrieve parts of vectors:

my_vector[4] # fourth element

[1] 0

my_vector[1:2] # first two elements

[1] 6 -11

Let’s check out some basic functions we can use with numbers and numeric vectors:

sqrt(my_object) # squared root

[1] 3.162278

log(my_object) # logarithm (natural by default)

[1] 2.302585

abs(-5) # absolute value

[1] 5

mean(my_vector)

[1] 5

median(my_vector)

[1] 6
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sd(my_vector) # standard deviation

[1] 11.53256

sum(my_vector)

[1] 25

min(my_vector) # minimum value

[1] -11

max(my_vector) # maximum value

[1] 20

length(my_vector) # length (number of elements)

[1] 5

Notice that if we wanted to save any of these results for later, we would need to assign them:

my_mean <- mean(my_vector)

my_mean

[1] 5

These functions are quite simple: they take one object and do one operation. A lot of functions
are a bit more complex—they take multiple objects or take options. For example, see the
sort() function, which by default sorts a vector increasingly:

sort(my_vector)

[1] -11 0 6 10 20

If we instead want to sort our vector decreasingly, we can use the decreasing = TRUE argument
(T also works as an abbreviation for TRUE).
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sort(my_vector, decreasing = TRUE)

[1] 20 10 6 0 -11

LIGHTBULB Tip

If you use the argument values in order, you can avoid writing the argument names (see
below). This is sometimes useful, but can also lead to confusing code—use it with caution.

sort(my_vector, T)

[1] 20 10 6 0 -11

A useful function to create vectors in sequence is seq(). Notice its arguments:

seq(from = 30, to = 100, by = 5)

[1] 30 35 40 45 50 55 60 65 70 75 80 85 90 95 100

To check the arguments of a function, you can examine its help file: look the function up on
the “Help” panel on RStudio or use a command like the following: ?sort.

INFO Exercise

Examine the help file of the log() function. How can we compute the the base-10
logarithm of my_object? Your code:

Other than numeric vectors, character vectors are also useful:

my_character_vector <- c("Apple", "Orange", "Watermelon", "Banana")

my_character_vector[3]

[1] "Watermelon"

nchar(my_character_vector) # count number of characters

[1] 5 6 10 6
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1.3 Data frames and lists

Another useful object type is the data frame. Data frames can store multiple vectors in a
tabular format. We can manually create one with the data.frame() function:

my_data_frame <- data.frame(fruit = my_character_vector,
calories_per_100g = c(52, 47, 30, 89),
water_per_100g = c(85.6, 86.8, 91.4, 74.9))

my_data_frame

fruit calories_per_100g water_per_100g
1 Apple 52 85.6
2 Orange 47 86.8
3 Watermelon 30 91.4
4 Banana 89 74.9

Now we have a little 4x3 data frame of fruits with their calorie counts and water composition.
We gathered the nutritional information from the USDA (2019).

We can use the data_frame$column construct to access the vectors within the data frame:

mean(my_data_frame$calories_per_100g)

[1] 54.5

INFO Exercise

Obtain the maximum value of water content per 100g in the data. Your code:

Some useful commands to learn attributes of our data frame:

dim(my_data_frame)

[1] 4 3

nrow(my_data_frame)

[1] 4
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names(my_data_frame) # column names

[1] "fruit" "calories_per_100g" "water_per_100g"

We will learn much more about data frames in our next module on data analysis.

After talking about vectors and data frames, the last object type that we will cover is the list.
Lists are super flexible objects that can contain just about anything:

my_list <- list(my_object, my_vector, my_data_frame)

my_list

[[1]]
[1] 10

[[2]]
[1] 6 -11 10 0 20

[[3]]
fruit calories_per_100g water_per_100g

1 Apple 52 85.6
2 Orange 47 86.8
3 Watermelon 30 91.4
4 Banana 89 74.9

To retrieve the elements of a list, we need to use double square brackets:

my_list[[1]]

[1] 10

Lists are sometimes useful due to their flexibility, but are much less common in routine data
analysis compared to vectors or data frames.
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1.4 Packages

The R community has developed thousands of packages, which are specialized collections of
functions, datasets, and other resources. To install one, you should use the install.packages()
command. Below we will install the tidyverse package, a suite for data analysis that we will
use in the next modules. You just need to install packages once, and then they will be available
system-wide.

install.packages("tidyverse") # this can take a couple of minutes

If you want to use an installed package in your script, you must load it with the library()
function. Some packages, as shown below, will print descriptive messages once loaded.

library(tidyverse)

-- Attaching core tidyverse packages ------------------------ tidyverse 2.0.0 --
v dplyr 1.2.0 v readr 2.1.6
v forcats 1.0.1 v stringr 1.6.0
v ggplot2 4.0.2 v tibble 3.3.1
v lubridate 1.9.5 v tidyr 1.3.2
v purrr 1.2.1
-- Conflicts ------------------------------------------ tidyverse_conflicts() --
x dplyr::filter() masks stats::filter()
x dplyr::lag() masks stats::lag()
i Use the conflicted package (<http://conflicted.r-lib.org/>) to force all conflicts to become errors

Exclamation-Triangle Warning

Remember that install.packages("package") needs to be executed just once, while
library(package) needs to be in each script in which you plan to use the package. In
general, never include install.packages("package") as part of your scripts or Quarto
documents!
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2 Tidy data analysis I

The tidyverse is a suite of packages that streamline data analysis in R. After installing the
tidyverse with install.packages("tidyverse") (see the previous module), you can load it
with:

library(tidyverse)

-- Attaching core tidyverse packages ------------------------ tidyverse 2.0.0 --
v dplyr 1.2.0 v readr 2.1.6
v forcats 1.0.1 v stringr 1.6.0
v ggplot2 4.0.2 v tibble 3.3.1
v lubridate 1.9.5 v tidyr 1.3.2
v purrr 1.2.1
-- Conflicts ------------------------------------------ tidyverse_conflicts() --
x dplyr::filter() masks stats::filter()
x dplyr::lag() masks stats::lag()
i Use the conflicted package (<http://conflicted.r-lib.org/>) to force all conflicts to become errors

LIGHTBULB Tip

Upon loading, the tidyverse prints a message like the one above. Notice that multiple
packages (the constituent elements of the “suite”) are actually loaded. For instance, dplyr
and tidyr help with data wrangling and transformation, while ggplot2 allows us to draw
plots. In most cases, one just loads the tidyverse and forgets about these details, as the
constituent packages work together nicely.

Throughout this module, we will use tidyverse functions to load, wrangle, and visualize real
data.

2.1 Loading data

Throughout this module we will work with a dataset of senators during the Trump presidency,
which was adapted from FiveThirtyEight (2021).
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We have stored the dataset in .csv format under the data/ subfolder. Loading it into R is
simple (notice that we need to assign it to an object):

trump_scores <- read_csv("data/trump_scores_538.csv")

Rows: 122 Columns: 8
-- Column specification --------------------------------------------------------
Delimiter: ","
chr (4): bioguide, last_name, state, party
dbl (4): num_votes, agree, agree_pred, margin_trump

i Use `spec()` to retrieve the full column specification for this data.
i Specify the column types or set `show_col_types = FALSE` to quiet this message.

trump_scores

# A tibble: 122 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 A000360 Alexander TN R 118 0.890 0.856 26.0
2 B000575 Blunt MO R 128 0.906 0.787 18.6
3 B000944 Brown OH D 128 0.258 0.642 8.13
4 B001135 Burr NC R 121 0.893 0.560 3.66
5 B001230 Baldwin WI D 128 0.227 0.510 0.764
6 B001236 Boozman AR R 129 0.915 0.851 26.9
7 B001243 Blackburn TN R 131 0.885 0.889 26.0
8 B001261 Barrasso WY R 129 0.891 0.895 46.3
9 B001267 Bennet CO D 121 0.273 0.417 -4.91
10 B001277 Blumenthal CT D 128 0.203 0.294 -13.6
# i 112 more rows

Let’s review the dataset’s columns:

• bioguide: A unique ID for each politician, from the Congress Bioguide.
• last_name
• state
• party
• num_votes: Number of votes for which data was available.
• agree: Proportion (0-1) of votes in which the senator voted in agreement with Trump.
• agree_pred: Predicted proportion of vote agreement, calculated using Trump’s margin

(see next variable).
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• margin_trump: Margin of victory (percentage points) of Trump in the senator’s state.

We can inspect our data by using the interface above. An alternative is to run the command
View(trump_scores) or click on the object in RStudio’s environment panel (in the top-right
section).

Do you have any questions about the data?

By the way, the tidyverse works amazingly with tidy data. If you can get your data to this
format (and we will see ways to do this), your life will be much easier:

2.2 Wrangling data with dplyr

We often need to modify data to conduct our analyses, e.g., creating columns, filtering rows, etc.
In the tidyverse, these operations are conducted with multiple verbs, which we will review
now.

2.2.1 Selecting columns

We can select specific columns in our dataset with the select() function. All dplyr wrangling
verbs take a data frame as their first argument—in this case, the columns we want to select are
the other arguments.

select(trump_scores, last_name, party)

# A tibble: 122 x 2
last_name party
<chr> <chr>

1 Alexander R
2 Blunt R
3 Brown D
4 Burr R
5 Baldwin D
6 Boozman R
7 Blackburn R
8 Barrasso R
9 Bennet D
10 Blumenthal D
# i 112 more rows
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(a) Source: Illustrations from the Openscapes blog Tidy Data for reproducibility, efficiency, and
collaboration by Julia Lowndes and Allison Horst.
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This is a good moment to talk about “pipes.” Notice how the code below produces the same
output as the one above, but with a slightly different syntax. Pipes (|>) “kick” the object
on the left of the pipe to the first argument of the function on the right. One can read pipes
as “then,” so the code below can be read as “take trump_scores, then select the columns
last_name and party.” Pipes are very useful to chain multiple operations, as we will see in a
moment.

trump_scores |>
select(last_name, party)

# A tibble: 122 x 2
last_name party
<chr> <chr>

1 Alexander R
2 Blunt R
3 Brown D
4 Burr R
5 Baldwin D
6 Boozman R
7 Blackburn R
8 Barrasso R
9 Bennet D
10 Blumenthal D
# i 112 more rows

LIGHTBULB Tip

You can insert a pipe with the Cmd/Ctrl + Shift + M shortcut. If you have not changed
the default RStudio settings, an “old” pipe (%>%) might appear. While most of the
functionality is the same, the |> “new” pipes are more readable and don’t need any
extra packages (to use %>% you need the tidyverse or one of its packages). You can
change this RStudio option in Tools > Global Options > Code > Use native pipe
operator. Make sure to check the other suggested settings in our Setup module!

Going back to selecting columns, you can select ranges:

trump_scores |>
select(bioguide:party)

# A tibble: 122 x 4
bioguide last_name state party
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<chr> <chr> <chr> <chr>
1 A000360 Alexander TN R
2 B000575 Blunt MO R
3 B000944 Brown OH D
4 B001135 Burr NC R
5 B001230 Baldwin WI D
6 B001236 Boozman AR R
7 B001243 Blackburn TN R
8 B001261 Barrasso WY R
9 B001267 Bennet CO D
10 B001277 Blumenthal CT D
# i 112 more rows

You can also deselect columns using a minus sign:

trump_scores |>
select(-last_name)

# A tibble: 122 x 7
bioguide state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 A000360 TN R 118 0.890 0.856 26.0
2 B000575 MO R 128 0.906 0.787 18.6
3 B000944 OH D 128 0.258 0.642 8.13
4 B001135 NC R 121 0.893 0.560 3.66
5 B001230 WI D 128 0.227 0.510 0.764
6 B001236 AR R 129 0.915 0.851 26.9
7 B001243 TN R 131 0.885 0.889 26.0
8 B001261 WY R 129 0.891 0.895 46.3
9 B001267 CO D 121 0.273 0.417 -4.91
10 B001277 CT D 128 0.203 0.294 -13.6
# i 112 more rows

And use a few helper functions, like matches():

trump_scores |>
select(last_name, matches("agree"))

# A tibble: 122 x 3
last_name agree agree_pred
<chr> <dbl> <dbl>
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1 Alexander 0.890 0.856
2 Blunt 0.906 0.787
3 Brown 0.258 0.642
4 Burr 0.893 0.560
5 Baldwin 0.227 0.510
6 Boozman 0.915 0.851
7 Blackburn 0.885 0.889
8 Barrasso 0.891 0.895
9 Bennet 0.273 0.417
10 Blumenthal 0.203 0.294
# i 112 more rows

Or everything(), which we usually use to reorder columns:

trump_scores |>
select(last_name, everything())

# A tibble: 122 x 8
last_name bioguide state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 Alexander A000360 TN R 118 0.890 0.856 26.0
2 Blunt B000575 MO R 128 0.906 0.787 18.6
3 Brown B000944 OH D 128 0.258 0.642 8.13
4 Burr B001135 NC R 121 0.893 0.560 3.66
5 Baldwin B001230 WI D 128 0.227 0.510 0.764
6 Boozman B001236 AR R 129 0.915 0.851 26.9
7 Blackburn B001243 TN R 131 0.885 0.889 26.0
8 Barrasso B001261 WY R 129 0.891 0.895 46.3
9 Bennet B001267 CO D 121 0.273 0.417 -4.91
10 Blumenthal B001277 CT D 128 0.203 0.294 -13.6
# i 112 more rows

LIGHTBULB Tip

Notice that all these commands have not edited our existent objects—they have just
printed the requested outputs to the screen. In order to modify objects, you need to use
the assignment operator (<-). For example:

trump_scores_reduced <- trump_scores |>
select(last_name, matches("agree"))

27



trump_scores_reduced

# A tibble: 122 x 3
last_name agree agree_pred
<chr> <dbl> <dbl>

1 Alexander 0.890 0.856
2 Blunt 0.906 0.787
3 Brown 0.258 0.642
4 Burr 0.893 0.560
5 Baldwin 0.227 0.510
6 Boozman 0.915 0.851
7 Blackburn 0.885 0.889
8 Barrasso 0.891 0.895
9 Bennet 0.273 0.417

10 Blumenthal 0.203 0.294
# i 112 more rows

INFO Exercise

Select the variables last_name, party, num_votes, and agree from the data frame. Your
code:

2.2.2 Renaming columns

We can use the rename() function to rename columns, with the syntax new_name = old_name.
For example:

trump_scores |>
rename(prop_agree = agree, prop_agree_pred = agree_pred)

# A tibble: 122 x 8
bioguide last_name state party num_votes prop_agree prop_agree_pred
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl>

1 A000360 Alexander TN R 118 0.890 0.856
2 B000575 Blunt MO R 128 0.906 0.787
3 B000944 Brown OH D 128 0.258 0.642
4 B001135 Burr NC R 121 0.893 0.560
5 B001230 Baldwin WI D 128 0.227 0.510
6 B001236 Boozman AR R 129 0.915 0.851
7 B001243 Blackburn TN R 131 0.885 0.889
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8 B001261 Barrasso WY R 129 0.891 0.895
9 B001267 Bennet CO D 121 0.273 0.417
10 B001277 Blumenthal CT D 128 0.203 0.294
# i 112 more rows
# i 1 more variable: margin_trump <dbl>

This is a good occasion to show how pipes allow us to chain operations. How do we read the
following code out loud? (Remember that pipes are read as “then”).

trump_scores |>
select(last_name, matches("agree")) |>
rename(prop_agree = agree, prop_agree_pred = agree_pred)

# A tibble: 122 x 3
last_name prop_agree prop_agree_pred
<chr> <dbl> <dbl>

1 Alexander 0.890 0.856
2 Blunt 0.906 0.787
3 Brown 0.258 0.642
4 Burr 0.893 0.560
5 Baldwin 0.227 0.510
6 Boozman 0.915 0.851
7 Blackburn 0.885 0.889
8 Barrasso 0.891 0.895
9 Bennet 0.273 0.417
10 Blumenthal 0.203 0.294
# i 112 more rows

2.2.3 Creating columns

It is common to want to create columns, based on existing ones. We can use mutate() to do
so. For example, we could want our main variables of interest in terms of percentages instead
of proportions:

trump_scores |>
select(last_name, agree, agree_pred) |> # select just for clarity
mutate(pct_agree = 100 * agree,

pct_agree_pred = 100 * agree_pred)
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# A tibble: 122 x 5
last_name agree agree_pred pct_agree pct_agree_pred
<chr> <dbl> <dbl> <dbl> <dbl>

1 Alexander 0.890 0.856 89.0 85.6
2 Blunt 0.906 0.787 90.6 78.7
3 Brown 0.258 0.642 25.8 64.2
4 Burr 0.893 0.560 89.3 56.0
5 Baldwin 0.227 0.510 22.7 51.0
6 Boozman 0.915 0.851 91.5 85.1
7 Blackburn 0.885 0.889 88.5 88.9
8 Barrasso 0.891 0.895 89.1 89.5
9 Bennet 0.273 0.417 27.3 41.7
10 Blumenthal 0.203 0.294 20.3 29.4
# i 112 more rows

We can also use multiple columns for creating a new one. For example, let’s retrieve the total
number of votes in which the senator agreed with Trump:

trump_scores |>
select(last_name, num_votes, agree) |> # select just for clarity
mutate(num_votes_agree = num_votes * agree)

# A tibble: 122 x 4
last_name num_votes agree num_votes_agree
<chr> <dbl> <dbl> <dbl>

1 Alexander 118 0.890 105
2 Blunt 128 0.906 116
3 Brown 128 0.258 33
4 Burr 121 0.893 108
5 Baldwin 128 0.227 29
6 Boozman 129 0.915 118
7 Blackburn 131 0.885 116
8 Barrasso 129 0.891 115
9 Bennet 121 0.273 33.0
10 Blumenthal 128 0.203 26
# i 112 more rows

2.2.4 Filtering rows

Another common operation is to filter rows based on logical conditions. We can do so with the
filter() function. For example, we can filter to only get Democrats:
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trump_scores |>
filter(party == "D")

# A tibble: 55 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 B000944 Brown OH D 128 0.258 0.642 8.13
2 B001230 Baldwin WI D 128 0.227 0.510 0.764
3 B001267 Bennet CO D 121 0.273 0.417 -4.91
4 B001277 Blumenthal CT D 128 0.203 0.294 -13.6
5 B001288 Booker NJ D 119 0.160 0.290 -14.1
6 C000127 Cantwell WA D 128 0.242 0.276 -15.5
7 C000141 Cardin MD D 128 0.25 0.209 -26.4
8 C000174 Carper DE D 129 0.295 0.318 -11.4
9 C001070 Casey PA D 129 0.287 0.508 0.724
10 C001088 Coons DE D 128 0.289 0.319 -11.4
# i 45 more rows

Notice that == here is a logical operator, read as “is equal to.” So our full chain of operations
says the following: take trump_scores, then filter it to get rows where party is equal to “D”.

There are other logical operators:

Logical operator Meaning

== “is equal to”
!= “is not equal to”
> “is greater than”
< “is less than”
>= “is greater than or equal to”
<= “is less than or equal to”
%in% “is contained in”
& “and” (intersection)
| “or” (union)

Let’s see a couple of other examples.

trump_scores |>
filter(agree > 0.5)
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# A tibble: 69 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 A000360 Alexander TN R 118 0.890 0.856 26.0
2 B000575 Blunt MO R 128 0.906 0.787 18.6
3 B001135 Burr NC R 121 0.893 0.560 3.66
4 B001236 Boozman AR R 129 0.915 0.851 26.9
5 B001243 Blackburn TN R 131 0.885 0.889 26.0
6 B001261 Barrasso WY R 129 0.891 0.895 46.3
7 B001310 Braun IN R 44 0.909 0.713 19.2
8 C000567 Cochran MS R 68 0.971 0.830 17.8
9 C000880 Crapo ID R 125 0.904 0.870 31.8
10 C001035 Collins ME R 129 0.651 0.441 -2.96
# i 59 more rows

trump_scores |>
filter(state %in% c("CA", "TX"))

# A tibble: 4 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 C001056 Cornyn TX R 129 0.922 0.659 9.00
2 C001098 Cruz TX R 126 0.921 0.663 9.00
3 F000062 Feinstein CA D 128 0.242 0.201 -30.1
4 H001075 Harris CA D 116 0.164 0.209 -30.1

trump_scores |>
filter(state == "WV" & party == "D")

# A tibble: 1 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 M001183 Manchin WV D 129 0.504 0.893 42.2

INFO Exercise

1. Add a new column to the data frame, called diff_agree, which subtracts agree
and agree_pred. How would you create abs_diff_agree, defined as the absolute
value of diff_agree? Your code:

2. Filter the data frame to only get senators for which we have information on fewer
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than (or equal to) five votes. Your code:

3. Filter the data frame to only get Democrats who agreed with Trump in at least
30% of votes. Your code:

2.2.5 Ordering rows

The arrange() function allows us to order rows according to values. For example, let’s order
based on the agree variable:

trump_scores |>
arrange(agree)

# A tibble: 122 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 H000273 Hickenlooper CO D 2 0 0.0302 -4.91
2 H000601 Hagerty TN R 2 0 0.115 26.0
3 L000570 Luján NM D 186 0.124 0.243 -8.21
4 G000555 Gillibrand NY D 121 0.124 0.242 -22.5
5 M001176 Merkley OR D 129 0.155 0.323 -11.0
6 W000817 Warren MA D 116 0.155 0.216 -27.2
7 B001288 Booker NJ D 119 0.160 0.290 -14.1
8 S000033 Sanders VT D 112 0.161 0.221 -26.4
9 H001075 Harris CA D 116 0.164 0.209 -30.1
10 M000133 Markey MA D 127 0.165 0.213 -27.2
# i 112 more rows

Maybe we only want senators with more than a few data points. Remember that we can chain
operations:

trump_scores |>
filter(num_votes >= 10) |>
arrange(agree)

# A tibble: 115 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 L000570 Luján NM D 186 0.124 0.243 -8.21
2 G000555 Gillibrand NY D 121 0.124 0.242 -22.5
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3 M001176 Merkley OR D 129 0.155 0.323 -11.0
4 W000817 Warren MA D 116 0.155 0.216 -27.2
5 B001288 Booker NJ D 119 0.160 0.290 -14.1
6 S000033 Sanders VT D 112 0.161 0.221 -26.4
7 H001075 Harris CA D 116 0.164 0.209 -30.1
8 M000133 Markey MA D 127 0.165 0.213 -27.2
9 W000779 Wyden OR D 129 0.186 0.323 -11.0
10 B001277 Blumenthal CT D 128 0.203 0.294 -13.6
# i 105 more rows

By default, arrange() uses increasing order (like sort()). To use decreasing order, add a
minus sign:

trump_scores |>
filter(num_votes >= 10) |>
arrange(-agree)

# A tibble: 115 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 M001198 Marshall KS R 183 0.973 0.933 20.6
2 C000567 Cochran MS R 68 0.971 0.830 17.8
3 H000338 Hatch UT R 84 0.964 0.825 18.1
4 M001197 McSally AZ R 136 0.949 0.562 3.55
5 P000612 Perdue GA R 119 0.941 0.606 5.16
6 C001096 Cramer ND R 135 0.941 0.908 35.7
7 R000307 Roberts KS R 127 0.937 0.818 20.6
8 C001056 Cornyn TX R 129 0.922 0.659 9.00
9 H001061 Hoeven ND R 129 0.922 0.883 35.7
10 C001047 Capito WV R 127 0.921 0.896 42.2
# i 105 more rows

You can also order rows by more than one variable. What this does is to order by the first
variable, and resolve any ties by ordering by the second variable (and so forth if you have more
than two ordering variables). For example, let’s first order our data frame by party, and then
within party order by agreement with Trump:

trump_scores |>
filter(num_votes >= 10) |>
arrange(party, agree)
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# A tibble: 115 x 8
bioguide last_name state party num_votes agree agree_pred margin_trump
<chr> <chr> <chr> <chr> <dbl> <dbl> <dbl> <dbl>

1 L000570 Luján NM D 186 0.124 0.243 -8.21
2 G000555 Gillibrand NY D 121 0.124 0.242 -22.5
3 M001176 Merkley OR D 129 0.155 0.323 -11.0
4 W000817 Warren MA D 116 0.155 0.216 -27.2
5 B001288 Booker NJ D 119 0.160 0.290 -14.1
6 S000033 Sanders VT D 112 0.161 0.221 -26.4
7 H001075 Harris CA D 116 0.164 0.209 -30.1
8 M000133 Markey MA D 127 0.165 0.213 -27.2
9 W000779 Wyden OR D 129 0.186 0.323 -11.0
10 B001277 Blumenthal CT D 128 0.203 0.294 -13.6
# i 105 more rows

INFO Exercise

Arrange the data by diff_agree, the difference between agreement and predicted agree-
ment with Trump. (You should have code on how to create this variable from the last
exercise). Your code:

2.2.6 Summarizing data

dplyr makes summarizing data a breeze using the summarize() function:

trump_scores |>
summarize(mean_agree = mean(agree),

mean_agree_pred = mean(agree_pred))

# A tibble: 1 x 2
mean_agree mean_agree_pred

<dbl> <dbl>
1 0.592 0.572

To make summaries, we can use any function that takes a vector and returns one value. Another
example:

trump_scores |>
filter(num_votes >= 5) |> # to filter out senators with few data points
summarize(max_agree = max(agree),

min_agree = min(agree))
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# A tibble: 1 x 2
max_agree min_agree

<dbl> <dbl>
1 1 0.124

Grouped summaries allow us to disaggregate summaries according to other variables (usually
categorical):

trump_scores |>
filter(num_votes >= 5) |> # to filter out senators with few data points
summarize(mean_agree = mean(agree),

max_agree = max(agree),
min_agree = min(agree),
.by = party) # to group by party

# A tibble: 2 x 4
party mean_agree max_agree min_agree
<chr> <dbl> <dbl> <dbl>

1 R 0.876 1 0.651
2 D 0.272 0.548 0.124

INFO Exercise

For each party, find the maximum absolute difference in agreement with Trump (the
abs_diff_agree variable from before).

2.2.7 Overview

Function Purpose

select() Select columns
rename() Rename columns
mutate() Creating columns
filter() Filtering rows
arrange() Ordering rows
summarize() Summarizing data
summarize(…, .by = ) Summarizing data (by groups)
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2.3 Visualizing data with ggplot2

ggplot2 is the package in charge of data visualization in the tidyverse. It is extremely flexible
and allows us to draw bar plots, box plots, histograms, scatter plots, and many other types of
plots (see examples at R Charts).

Throughout this module we will use a subset of our data frame, which only includes senators
with more than a few data points:

trump_scores_ss <- trump_scores |>
filter(num_votes >= 10)

The ggplot2 syntax provides a unifying interface (the “grammar of graphics” or “gg”) for
drawing all different types of plots. One draws plots by adding different “layers,” and the core
code always includes the following:

• A ggplot() command with a data = argument specifying a data frame and a mapping
= aes() argument specifying “aesthetic mappings,” i.e., how we want to use the columns
in the data frame in the plot (for example, in the x-axis, as color, etc.).

• “geoms,” such as geom_bar() or geom_point(), specifying what to draw on the plot.

So all ggplot2 commands will have at least three elements: data, aesthetic mappings, and
geoms.

2.3.1 Univariate plots: categorical

Let’s see an example of a bar plot with a categorical variable:

ggplot(data = trump_scores_ss, mapping = aes(x = party)) +
geom_bar()
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LIGHTBULB Tip

As with any other function, we can drop the argument names if we specify the argument
values in order. This is common in ggplot2 code:

ggplot(trump_scores_ss, aes(x = party)) +
geom_bar()

38



0

20

40

60

D R
party

co
un

t

Notice how geom_bar() automatically computes the number of observations in each category
for us. Sometimes we want to use numbers in our data frame as part of a bar plot. Here we can
use the geom_col() geom specifying both x and y aesthetic mappings, in which is sometimes
called a “column plot:”

ggplot(trump_scores_ss |> filter(state == "ME"),
aes(x = last_name, y = agree)) +

geom_col()
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INFO Exercise

Draw a column plot with the agreement with Trump of Bernie Sanders and Ted Cruz.
What happens if you use last_name as the y aesthetic mapping and agree in the x
aesthetic mapping? Your code:

A common use of geom_col() is to create “ranking plots.” For example, who are the senators
with highest agreement with Trump? We can start with something like this:

ggplot(trump_scores_ss,
aes(x = agree, y = last_name)) +

geom_col()
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We might want to (1) select the top 10 observations and (2) order the bars according to the
agree values. We can do these operations with slice_max() and fct_reorder(), as shown
below:

ggplot(trump_scores_ss |> slice_max(agree, n = 10),
aes(x = agree, y = fct_reorder(last_name, agree))) +

geom_col()
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We can also plot the senators with the lowest agreement with Trump using slice_min() and
fct_reorder() with a minus sign in the ordering variable:

ggplot(trump_scores_ss |> slice_min(agree, n = 10),
aes(x = agree, y = fct_reorder(last_name, -agree))) +

geom_col()
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2.3.2 Univariate plots: numerical

We can draw a histogram with geom_histogram():

ggplot(trump_scores_ss, aes(x = agree)) +
geom_histogram()

`stat_bin()` using `bins = 30`. Pick better value `binwidth`.
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Notice the warning message above. It’s telling us that, by default, geom_histogram() will
draw 30 bins. Sometimes we want to modify this behavior. The following code has some
common options for geom_histogram() and their explanations:

ggplot(trump_scores_ss, aes(x = agree)) +
geom_histogram(binwidth = 0.05, # draw bins every 0.05 jumps in x

boundary = 0, # don't shift bins to integers
closed = "left") # close bins on the left

44



0

5

10

15

20

0.25 0.50 0.75 1.00
agree

co
un

t

Sometimes we want to manually alter a scale. This is accomplished with the scale_*() family
of ggplot2 functions. Here we use the scale_x_continuous() function to make the x-axis go
from 0 to 1:

ggplot(trump_scores_ss, aes(x = agree)) +
geom_histogram(binwidth = 0.05, boundary = 0, closed = "left") +
scale_x_continuous(limits = c(0, 1))
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Adding the fill aesthetic mapping to a histogram will divide it according to a categorical
variable. This is actually a bivariate plot!

ggplot(trump_scores_ss, aes(x = agree, fill = party)) +
geom_histogram(binwidth = 0.05, boundary = 0, closed = "left") +
scale_x_continuous(limits = c(0, 1)) +
# change default colors:
scale_fill_manual(values = c("D" = "blue", "R" = "red"))
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2.3.3 Bivariate plots

Another common bivariate plot for categorical and numerical variables is the grouped box
plot:

ggplot(trump_scores_ss, aes(x = agree, y = party)) +
geom_boxplot() +
scale_x_continuous(limits = c(0, 1)) # same change as before
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For bivariate plots of numerical variables, scatter plots are made with geom_point():

ggplot(trump_scores_ss, aes(x = margin_trump, y = agree)) +
geom_point()
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We can add the color aesthetic mapping to add a third variable:

ggplot(trump_scores_ss, aes(x = margin_trump, y = agree, color = party)) +
geom_point() +
scale_color_manual(values = c("D" = "blue", "R" = "red"))
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Let’s finish our plot with the labs() function, which allows us to add labels to our aesthetic
mappings, as well as titles and notes:

ggplot(trump_scores, aes(x = margin_trump, y = agree, color = party)) +
geom_point() +
scale_color_manual(values = c("D" = "blue", "R" = "red")) +
labs(x = "Trump margin in the senator's state (p.p.)",

y = "Votes in agreement with Trump (prop.)",
color = "Party",
title = "Relationship between Trump margins and senators' votes",
caption = "Data source: FiveThirtyEight (2021)")

49



0.00

0.25

0.50

0.75

1.00

−20 0 20 40
Trump margin in the senator's state (p.p.)

V
ot

es
 in

 a
gr

ee
m

en
t w

ith
 T

ru
m

p 
(p

ro
p.

)

Party

D

R

Relationship between Trump margins and senators' votes

Data source: FiveThirtyEight (2021)

We will review a few more customization options, including text labels and facets, in a
subsequent module.
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3 Functions

3.1 Basics

3.1.1 What is a function?

Informally, a function is anything that takes input(s) and gives one defined output. There are
always three main parts:

• The input (𝑥 values, or each value in the domain)

• The relationship of interest

• The output (𝑦 values, or a unique value in the range)

INFO Note

“𝑓(𝑥) = ... is the classic notation for writing a function, but we can also use”𝑦 = ...“. This
is because 𝑦 is”a function of” 𝑥, so 𝑦 = 𝑓(𝑥).

Let’s take a look at an example and break down the structure:

𝑓(𝑥) = 3𝑥 + 4

• 𝑥 is the input (some value) that the function takes.

• For any 𝑥, we multiply by three and add 4, which is the relationship.

• Finally, 𝑓(𝑥) or 𝑦 is the unique result, or the output.

The most common name to give a function is, predictably, “𝑓”, but we can have other names
such as “𝑔” or “ℎ”. The choice is yours.

Exclamation Important

When reading out loud, we say “[name of function] of x equals [relationship]. For example,
𝑓(𝑥) = 𝑥2 is referred to as”f of x equals x squared.”
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Figure 3.1: Function machine. Source: Bill Bailey on Wikimedia Commons.
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3.1.2 Vertical line test

INFO Exercise

When graphed, vertical lines cannot touch functions at more than one point. Why?
Which of the following represent functions?

Figure 3.2: Vertical line test: examples.

3.2 Functions in R

Often we need to create our own functions in R. To build them: we use the keyword function
alongside the following syntax: function_name <- function(argumentnames){ operation
}

• function_name: the name of the function, that will be stored as an object in the R
environment. Make the name concise and memorable!

• function(argumentnames): the inputs of the function.

• { operation }: a set of commands that are run in a predefined order every time we call
the function.
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For example, we can create a function that multiplies a number by 2:

mult_by_two <- function(x){x * 2}

mult_by_two(x = 5) # we can also omit the argument name (x =)

[1] 10

If the function body works for vectors, our custom function will do too:

mult_by_two(1:10)

[1] 2 4 6 8 10 12 14 16 18 20

We can also automate more complicated tasks such as calculating the area of a circle from its
radius:

circ_area_r <- function(r){
pi * r ^ 2

}
circ_area_r(r = 3)

[1] 28.27433

INFO Exercise

Create a function that calculates the area of a circle from its diameter. So
your_function(d = 6) should yield the same result as the example above. Your code:

Functions can take more than one argument/input. In a silly example, let’s generalize our first
function:

mult_by <- function(x, mult){x * mult}

mult_by(x = 1:5, mult = 10)

[1] 10 20 30 40 50
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mult_by(1:5, mult = 10)

[1] 10 20 30 40 50

mult_by(1:5, 10)

[1] 10 20 30 40 50

To graph a function, we’ll use our friend ggplot2 and stat_function():

library(tidyverse)

-- Attaching core tidyverse packages ------------------------ tidyverse 2.0.0 --
v dplyr 1.2.0 v readr 2.1.6
v forcats 1.0.1 v stringr 1.6.0
v ggplot2 4.0.2 v tibble 3.3.1
v lubridate 1.9.5 v tidyr 1.3.2
v purrr 1.2.1
-- Conflicts ------------------------------------------ tidyverse_conflicts() --
x dplyr::filter() masks stats::filter()
x dplyr::lag() masks stats::lag()
i Use the conflicted package (<http://conflicted.r-lib.org/>) to force all conflicts to become errors

ggplot() +
stat_function(fun = mult_by_two,

xlim = c(-5, 5)) # domain over which we will plot the function
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User-defined functions have endless possibilities! We encourage you to get creative and try to
automate new tasks when possible, especially if they are repetitive.

LIGHTBULB Tip

Functions in R can also take non-numeric inputs. For example:

say_my_name <- function(my_name){paste("My name is", my_name)}

say_my_name("Inigo Montoya")

[1] "My name is Inigo Montoya"

3.3 Common types of functions

3.3.1 Linear functions

𝑦 = 𝑚𝑥 + 𝑏

Linear functions are those whose graph is a straight line (in two dimensions).
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• 𝑚 is the slope, or the rate of change (common interpretation: for every one unit increase
in 𝑥, 𝑦 increases 𝑚 units).

• 𝑏 is the y intercept, or the constant term (the value of 𝑦 when 𝑥 = 0).

Below is a graph of the function 𝑦 = 3𝑥 + 4:

ggplot() +
stat_function(fun = function(x){3 * x + 4}, # we don't need to create an object

xlim = c(-5, 5))

−10

0

10

20

−5.0 −2.5 0.0 2.5 5.0
x

y

3.3.2 Quadratic functions

𝑦 = 𝑎𝑥2 + 𝑏𝑥 + 𝑐

Quadratic functions take “U” forms. If 𝑎 is positive, it is a regular “U” shape. If 𝑎 is negative,
it is an “inverted U” shape.

Note that 𝑥2 always returns positive values (or zero).

Below is a graph of the function 𝑦 = 𝑥2:
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ggplot() +
stat_function(fun = function(x){x ^ 2},

xlim = c(-5, 5))
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INFO Exercise

Social scientists commonly use linear or quadratic functions as theoretical simplifications
of social phenomena. Can you give any examples?

INFO Exercise

Graph the function 𝑦 = 𝑥2 + 2𝑥 − 10, i.e., a quadratic function with 𝑎 = 1, 𝑏 = 2, and
𝑐 = −10.
Next, try switching up these values and the xlim = argument. How do they each alter
the function (and plot)?

3.3.3 Cubic functions

𝑦 = 𝑎𝑥3 + 𝑏𝑥2 + 𝑐𝑥 + 𝑑

These lines (generally) have two curves (inflection points).
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Below is a graph of the function 𝑦 = 𝑥3:

ggplot() +
stat_function(fun = function(x){x ^ 3},

xlim = c(-5, 5))
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INFO Exercise

We’ll briefly introduce Desmos, an online graphing calculator. Use Desmos to graph the
following function 𝑦 = 1𝑥3 + 1𝑥2 + 1𝑥 + 1. What happens when you change the 𝑎, 𝑏, 𝑐,
and 𝑑 parameters?

3.3.4 Polynomial functions

𝑦 = 𝑎𝑥𝑛 + 𝑏𝑥𝑛−1 + ... + 𝑐

These functions have (a maximum of) 𝑛 − 1 changes in direction (turning points). They also
have (a maximum of) 𝑛 x-intercepts.

High-order polynomials can be made arbitrarily precise!

Below is a graph of the function 𝑦 = 1
4𝑥

4 − 5𝑥2 + 𝑥.
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ggplot() +
stat_function(fun = function(x){1/4 * x ^ 4 - 5 * x ^ 2 + x},

xlim = c(-5, 5))
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3.3.5 Exponential functions

𝑦 = 𝑎𝑏𝑥

Here our input (𝑥), is the exponent.

Below is a graph of the function 𝑦 = 2𝑥:

ggplot() +
stat_function(fun = function(x){2 ^ x},

xlim = c(-5, 5))
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INFO Exercise

Exponential growth appears quite frequently social science theories. Which variables can
be theorized to have exponential growth over time?

3.4 Logarithms and exponents

3.4.1 Logarithms

Logarithms are the opposite/inverse of exponents. They ask how many times you must raise
the base to get 𝑥.

So 𝑙𝑜𝑔𝑎(𝑏) = 𝑥 is asking “a raised to what power x gives b?” For example, log3(81) = 4 because
34 = 81.

Exclamation-Triangle Warning

Logarithms are undefined if the base is ≤ 0 (at least in the real numbers).
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3.4.2 Relationships

If,
𝑙𝑜𝑔𝑎𝑥 = 𝑏

then,
𝑎𝑙𝑜𝑔𝑎𝑥 = 𝑎𝑏

and
𝑥 = 𝑎𝑏

3.4.3 Basic rules

• Change of Base rule:
log𝑥 𝑛
log𝑥 𝑚

= log𝑚 𝑛

• Product Rule: log𝑥(𝑎𝑏) = log𝑥 𝑎 + log𝑥 𝑏

• Quotient Rule: log𝑥 (𝑎
𝑏 ) = log𝑥 𝑎 − log𝑥 𝑏

• Power Rule: log𝑥 𝑎𝑏 = 𝑏 log𝑥 𝑎

• Logarithm of 1: log𝑥 1 = 0

• Logarithm of the Base: 𝑙𝑜𝑔𝑥𝑥 = 1

• Exponential Identity: 𝑚log𝑚(𝑎) = 𝑎

3.4.4 Natural logarithms

• We most often use natural logarithms for our purposes.

• This means 𝑙𝑜𝑔𝑒(𝑥), which is usually written as 𝑙𝑛(𝑥).

Exclamation Important

𝑒 ≈ 2.7183.

• 𝑙𝑛(𝑥) and its exponent opposite, 𝑒𝑥, have nice properties when we perform calculus.

62



3.4.5 Illustration of 𝑒

Imagine you invest $1 in a bank and receive 100% interest for one year, and the bank pays you
back once a year:

(1 + 1)1 = 2

.

When it pays you twice a year with compound interest:

(1 + 1/2)2 = 2.25

If it pays you three times a year:

(1 + 1/3)3 = 2.37...

What will happen when the bank pays you once a month? Once a day?

(1 + 1
𝑛
)𝑛

However, there is limit to what you can get.

lim
𝑛→∞

(1 + 1
𝑛
)𝑛 = 2.7183... = 𝑒

For any interest rate 𝑘 and number of times the bank pays you 𝑡:

lim
𝑛→∞

(1 + 𝑘
𝑛
)𝑛𝑡 = 𝑒𝑘𝑡

𝑒 is important for defining exponential growth. Since 𝑙𝑛(𝑒𝑥) = 𝑥, the natural
logarithm helps us turn exponential functions into linear ones.

INFO Exercise

Solve the problems below, simplifying as much as you can.

𝑙𝑜𝑔10(1000)

𝑙𝑜𝑔2(
8
32

)

10𝑙𝑜𝑔10(300)

𝑙𝑛(1)
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𝑙𝑛(𝑒2)

𝑙𝑛(5𝑒)

3.4.6 Logarithms in R

By default, R’s log() function computes natural logarithms:

log(100)

[1] 4.60517

We can change this behavior with the base = argument:

log(100, base = 10)

[1] 2

We can also plot logarithms. Remember that 𝑙𝑛(𝑥) ∀𝑥 < 0 is undefined (at least in the real
numbers), and ggplot2 displays a nice warning letting us know!

ggplot() +
stat_function(fun = function(x){log(x)},

xlim = c(-5, 5))

Warning in log(x): NaNs produced

Warning: Removed 50 rows containing missing values or values outside the scale range
(`geom_function()`).

64



−2

−1

0

1

−5.0 −2.5 0.0 2.5 5.0
x

y

ggplot() +
stat_function(fun = function(x){log(x)},

xlim = c(1, 100))
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3.5 Composite functions (functions of functions)

Functions can take other functions as inputs, e.g., 𝑓(𝑔(𝑥)). This means that the outside function
takes the output of the inside function as its input.

Say we have the exterior function
𝑓(𝑥) = 𝑥2

and the interior function
𝑔(𝑥) = 𝑥 − 3

.

Then if we want 𝑓(𝑔(𝑥)), we would subtract 3 from any input, and then square the result or

𝑓(𝑔(𝑥)) = (𝑥 − 3)2

.

Exclamation-Triangle Warning

We write this as (𝑥 − 3)2, not 𝑥2 − 3!

R can handle this just fine:

f <- function(x){x ^ 2}
g <- function(x){x - 3}

f(g(5))

[1] 4

Here we can also use pipes to make this code more readable (imagine if we were chaining
multiple functions…). Remember that pipes can be inserted with the Cmd/Ctrl + Shift + M
shortcut.

# compute g(5), THEN f() of that
g(5) |> f()

[1] 4
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INFO Exercise

Compute g(f(5)) using the definitions above. First do it manually, and then check your
answer with R.
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4 Calculus

In this section we’ll focus on three big ideas from calculus: derivatives, optimization, and
integrals.

4.1 Derivatives

Derivatives are about (instantaneous) rate of change.

“In the fall of 1972 President Nixon announced that the rate of increase of inflation
was decreasing. This was the first time a sitting president used the third derivative
to advance his case for reelection” (Rossi 1996)

Let’s dissect what Nixon might have said:

Inflation’s [first derivative, of prices] rate of increase [second derivative] is going
down [third derivative].

A more graphical way to think about a derivatives is as a slope. Let’s consider a linear function
of the form 𝑦 = 2𝑥:

library(tidyverse) # could also just do library(ggplot2)
ggplot() +
stat_function(fun = function(x){2 * x},

xlim = c(-10, 10))
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We can imagine any political variables in the x- and y-axes. What is the rate of change? In
other words, what is the derivative? Remember that we can calculate the slope with:

𝑚 = 𝑓(𝑥2) − 𝑓(𝑥1)
𝑥2 − 𝑥1

Now consider another slightly more complicated function, a quadratic one, 𝑦 = 𝑥2:

ggplot() +
stat_function(fun = function(x){x ^ 2},

xlim = c(-10, 10))
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What happens when we apply our slope function?

INFO Exercise

1) Use the slope formula to calculate the rate of change between 5 and 6.

2) Use the slope formula to calculate the rate of change between 5 and 5.5.

3) Use the slope formula to calculate the rate of change between 5 and 5.1.

Takeaway: here the derivative depends on the value of 𝑥. It is actually 2𝑥.

Differential calculus is about finding these derivatives in a more straightforward manner! We
can generalize our slope formula as follows:

𝑚 = 𝑓(𝑥1 +Δ𝑥) − 𝑓(𝑥1)
Δ𝑥

The point is that when Δ𝑥 is arbitrarily small, we’ll get our rate of change. Formalizing this:

lim
Δ𝑥→0

𝑓(𝑥1 +Δ𝑥) − 𝑓(𝑥1)
Δ𝑥

= 𝑑
𝑑𝑥

𝑓(𝑥) = 𝑑𝑦
𝑑𝑥

= 𝑓 ′(𝑥)

A few points on notation:
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• 𝑑
𝑑𝑥𝑓(𝑥) is read “The derivative of 𝑓 of 𝑥 with respect to 𝑥.”

– The variable with respect to which we’re differentiating is the one that appears in
the bottom (in the case above, this is 𝑥).

Exclamation-Triangle Warning

While the above looks like a fraction, it’s really not. Do not try to cancel out the 𝑑s!

• 𝑓 ′(𝑥) (read: “𝑓 prime 𝑥”) is the derivative of 𝑓(𝑥). This is a more compact form to refer
to derivatives when you have defined 𝑓(𝑥) elsewhere.

4.1.1 Rules of differentiation

How to compute derivatives? Sometimes you can try a bunch of numbers and get at the
answer. Sometimes you can use the limit-based formula above, if you know a few properties
of limits. But in most cases you will either use software (more on this later) or the rules of
differentiation, which we will cover now.

Constant rule: (𝑐)′ = 0.

There is no change in a constant:

ggplot() +
stat_function(fun = function(x){2}, xlim = c(-10, 10))
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Coefficient rule: (𝑐 ⋅ 𝑓(𝑥))′ = 𝑐 ⋅ 𝑓 ′(𝑥).

ggplot() +
stat_function(fun = function(x){2 * x}, xlim = c(-10, 10), aes(color = "y = 2x")) +
stat_function(fun = function(x){4 * x}, xlim = c(-10, 10), aes(color = "y = 4x")) +
scale_color_manual("Function", values = c("red", "blue"))
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Sum/difference rule: (𝑓(𝑥) ± 𝑔(𝑥))′ = 𝑓 ′(𝑥) ± 𝑔′(𝑥).

The two rules above give us that the derivative is a linear operator.

Power rule: (𝑥𝑛)′ = 𝑛𝑥(𝑛−1)

Remember when we wanted to calculate the derivative of 𝑦 = 𝑥2 above? We can use the power
rule, with 𝑛 = 2: 𝑛𝑥(𝑛−1) = 2𝑥(2−1) = 2𝑥. Let’s try out 𝑑

𝑑𝑥4𝑥
3 and 𝑑

𝑑𝑥(𝑥
2 +2𝑥) on the board.

INFO Exercise

Use the differentiation rules we have covered so far to calculate the derivatives of 𝑦 with
respect to 𝑥 of the following functions:

1) 𝑦 = 2𝑥2 + 10
2) 𝑦 = 5𝑥4 − 2

3𝑥
3

3) 𝑦 = 9
√
𝑥

4) 𝑦 = 4
𝑥2

5) 𝑦 = 𝑎𝑥3 + 𝑏, where 𝑎 and 𝑏 are constants.
6) 𝑦 = 2𝑤

5

Exponent and logarithm rules:
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(𝑐𝑥)′ = 𝑐𝑥 ⋅ 𝑙𝑛(𝑐), ∀𝑥 > 0
(𝑒𝑥)′ = 𝑒𝑥

(𝑙𝑜𝑔𝑎(𝑥))′ = 1
𝑥 ⋅ 𝑙𝑛(𝑎)

, ∀𝑥 > 0

(𝑙𝑛(𝑥))′ = 1
𝑥
, ∀𝑥 > 0

We saw previously how Euler’s number (𝑒) arises from compound interest. The properties
above make it very useful in a lot of calculus applications!

INFO Exercise

Compute the following:

1) 𝑑
𝑑𝑥(10𝑒

𝑥)
2) 𝑑

𝑑𝑥(𝑙𝑛(𝑥) −
𝑒2

3 )

Now we’ll get to a couple of more advanced (and powerful) rules.

• Product rule: (𝑓(𝑥)𝑔(𝑥))′ = 𝑓 ′(𝑥)𝑔(𝑥) + 𝑔′(𝑥)𝑓(𝑥)

• Quotient rule: (𝑓(𝑥)
𝑔(𝑥)

)′ = 𝑓 ′(𝑥)𝑔(𝑥) − 𝑔′(𝑥)𝑓(𝑥)
[𝑔(𝑥)]2

• Chain rule: (𝑓(𝑔(𝑥))′ = 𝑓 ′(𝑔(𝑥)) ⋅ 𝑔′(𝑥)

Let’s calculate 𝑑
𝑑𝑥(3 ⋅ 𝑙𝑛(𝑥) ⋅ 𝑥2) on the board.

Let’s compute 𝑑
𝑑𝑥(𝑒

𝑥2) on the board.

INFO Exercise

Use the differentiation rules we have covered so far to calculate the derivatives of 𝑦 with
respect to 𝑥 of the following functions:

1) 𝑥3 ⋅ 𝑥
2) 𝑒𝑥 ⋅ 𝑥2

3) (3𝑥4 − 8)2
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4.1.2 Higher-order derivatives

We saw how politicians can refer to higher-order derivatives. To compute them, you simply
“pass the outputs,” starting from the lowest order and going up.

The second derivative tells us whether the slope of a function is increasing, decreasing, or
staying the same at any point 𝑥 on the function’s domain. For example, when driving a car:

• 𝑓(𝑥) = distance traveled at time 𝑥
• 𝑓 ′(𝑥) = speed at time 𝑥
• 𝑓″(𝑥) = acceleration at time 𝑥

Let’s compute the following second derivative:

𝑓″(𝑥4) = 𝑑2(𝑥4)
𝑑𝑥2

• First, we take the first derivative: 𝑓 ′(𝑥4) = 4𝑥3

• Then we use that output to take the second derivative: 𝑓″(𝑥4) = 𝑓 ′(4𝑥3) = 12𝑥2

• We can keep going… for example, the third derivative:

𝑓‴(𝑥4) = 𝑓 ′(12𝑥2) = 24𝑥

INFO Exercise

Compute the following:

1) 𝑑3

𝑑𝑥3 (𝑥5)
2) 𝑓″(4𝑥3/2)
3) 𝑓″(4 ⋅ 𝑙𝑛(𝑥))

4.1.3 Partial derivatives

For a function 𝑓(𝑥, 𝑧), we might want to know how the function changes with respect to 𝑥. We
call this a partial derivative:

𝜕
𝜕𝑥

𝑓(𝑥, 𝑧) =
𝜕𝑦

𝜕𝑥
= 𝜕𝑥𝑓

To obtain a partial derivative, we treat all other variables as constants and take the derivative
with respect to the variable of interest (here 𝑥). For example:
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𝑦 = 𝑓(𝑥, 𝑧) = 𝑥𝑧
𝜕𝑦

𝜕𝑥
= 𝑧

What is
𝜕𝑦

𝜕𝑧
?

Let’s solve 𝜕(𝑥2𝑦 + 𝑥𝑦2 − 𝑥)
𝜕𝑥

and 𝜕(𝑥2𝑦 + 𝑥𝑦2 − 𝑥)
𝜕𝑦

on the board.

LIGHTBULB Example

Let’s say that 𝑦 is how much I like a movie, 𝑑 is how many dogs a movie has, and 𝑒 is
how many explosions a movie has. I claim that how much I like a movie can be expressed
by a function of the type 𝑦 = 𝑓(𝑑, 𝑒). Evaluate the following situations:

1. I like dogs and I don’t care about action. So I believe that the true relationship is

𝑦 = 𝑓(𝑑, 𝑒) = 3 ⋅ 𝑑. What is
𝜕𝑦

𝜕𝑑
, and how can we interpret it?

2. I like dogs and I like action. So I believe that the true relationship is 𝑦 = 𝑓(𝑑, 𝑒) =

3 ⋅ 𝑑 + 1 ⋅ 𝑒. What is
𝜕𝑦

𝜕𝑑
, and how can we interpret it?

3. I like dogs and I like action. But I definitely don’t like them together—I don’t want
the dogs to be in danger! So I believe that the true relationship is 𝑦 = 𝑓(𝑑, 𝑒) =

3 ⋅ 𝑑 + 1 ⋅ 𝑒 − 10 ⋅ 𝑑 ⋅ 𝑒. What is
𝜕𝑦

𝜕𝑑
, and how can we interpret it?

INFO Exercise

Take the partial derivative with respect to 𝑥 and with respect to 𝑧 of the following
functions. What would the notation for each look like?

1) 𝑦 = 3𝑥𝑧 − 𝑥
2) 𝑥3 + 𝑧3 + 𝑥4𝑧4

3) 𝑒𝑥𝑧

4.1.4 Differentiability of functions

Not all functions are differentiable at every point of their domains!

An important concept here is whether functions are continuous at a point:
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• Informally: A function is continuous at a point if its graph has no holes or breaks at that
point

• Formally: A function is continuous at a point 𝑎 if: lim𝑥→𝑎 𝑓(𝑥) = 𝑓(𝑎)

When is a function differentiable at a point?

• If a function is differentiable at a point, it is also continuous at that point.

• If a function is continuous at a point, it is not necessarily differentiable at that point.

– Impossible to calculate derivative at sharp turns, cusps, or vertical tangents.

ggplot() +
stat_function(fun = function(x){abs(x) + 2}, xlim = c(-4, 4),

aes(color = "y = |x| + 2")) +
stat_function(fun = function(x){sqrt(abs(x)) + 1}, xlim = c(-4, 4),

aes(color = "y = √(|x|) + 1")) +
stat_function(fun = function(x){sign(x) * abs(x)^(1 / 3)}, xlim = c(-4, 4),

aes(color = "y = �√x")) +
scale_colour_manual("Function", values = c("red", "blue", "black")) +
labs(title = "Examples of functions that are not differentiable at x=0")
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y = |x| + 2

y = ...(|x|) + 1

y = ......x

Examples of functions that are not differentiable at x=0

Informally, functions need to be continuous and reasonably smooth to be differen-
tiable.
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4.1.5 How do computers calculate derivatives?

In quite a few statistics and machine learning problems, computers need to compute derivatives
of arbitrarily complex functions, perhaps millions of times. How do they do it? (see Baydin et
al. 2018 for discussion of these three approaches)

• Symbolic differentiation: automatically combine the rules of differentiation (power rule,
product rule, etc.). It is what math solvers use, e.g., WolframAlpha or (presumably)
Symbolab.

• Numerical differentiation: infer the derivative by computing the function at different
sample values (like we did with 𝑦 = 𝑥2 before. This is what, for example, R’s optim()
function does behind the scenes.

# minimize the x^2 + 5 function:
optim(par = 0, fn = function(x){x ^ 2 + 5}, method = "L-BFGS-B")

$par
[1] 0

$value
[1] 5

$counts
function gradient

1 1

$convergence
[1] 0

$message
[1] "CONVERGENCE: NORM OF PROJECTED GRADIENT <= PGTOL"

• Automatic differentiation: track how every function is constructed from (differentiable)
elementary computer operations (e.g., binary arithmetic), and get the result using the
chain rule. Implemented in the torch R package, the TensorFlow, PyTorch, and JAX
Python libraries, and the ReverseDiff.jl and Zygote.jl Julia packages.
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Figure 4.1: An example of computing the gradient of an esoteric function using Zygote.jl (from
its documentation)

4.2 Optimization

Optimization allows us to find the minimum or maximum values (or extrema) a function takes.
It has many applications in the social sciences:

• Formal theory: utility maximization, continuous choices

• Ordinary Least Squares (OLS): Focuses on minimizing the squared errors between
observed data and model-estimated values

• Maximum Likelihood Estimation (MLE): Focuses on maximizing a likelihood function,
given observed values.
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4.2.1 Extrema

On extrema: informally, a maximum is just the highest value a function takes, and a minimum
is the lowest value.

In some situations, it can be easy to identify extrema intuitively by looking at a graph of the
function.

• Maxima are high points (“peaks”)

• Minima are low points (“valleys”)

We can use derivatives (rates of change!) to get at extrema.

4.2.2 Critical points and the First-Order Condition

At critical points (or stationary points), the derivative is zero or fails to exist. At these, the
function has usually reached a (local) maximum or minimum.

• At a maximum, the function must be increasing before the point and decreasing after it.

• At a minimum, the function must be decreasing before the point and increasing after it.

Exclamation-Triangle Warning

Local extrema occur at critical points, but not all critical points are extrema. For instance,
sometimes the graph is changing between concave and convex (“inflection points”). Or
sometimes the function is not differentiable at that point for other reasons.

We can find the local maxima and/or minima of a function by taking the derivative, setting it
equal to zero, and solving for 𝑥 (or whatever variable). This gives us the First-Order Condition
(FOC).

𝐹𝑂𝐶 ∶ 𝑓 ′(𝑥) = 0

4.2.3 Second-Order Condition

Notice that after this we only know that there is a critical point. BUT we don’t know if we’ve
found a maximum or minimum, or even if we’ve found an extremum.

To determine whether a we are seeing a (local) maximum or minimum, we can use the Second
Derivative Test:

• Start by identifying 𝑓″(𝑥)
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• Substitute in the stationary points (𝑥∗) identified from the FOC.

– 𝑓″(𝑥∗) > 0 we have a local minimum

– 𝑓″(𝑥∗) < 0 we have a local maximum

– 𝑓″(𝑥∗) = 0 we (may) have an inflection point - need to calculate higher-order
derivatives (don’t worry about this now)

Collectively these give us the Second-Order Condition (SOC).

Let’s do this procedure and obtain the FOC and SOC for 𝑦 = 1
2
𝑥3 + 3𝑥2 − 2 on the board.

What do we learn? Compare this with the plot of the function on Desmos.

4.2.4 Local or global extrema?

Now when it comes to knowing whether extrema are local or global:

• Here we use the Extreme value theorem, which states that if a real-valued function
is continuous on a closed and bounded (i.e., finite) interval, the function must have a
global minimum and a global minimum on that interval at least once. Importantly, in
this situation the global extrema exist, and they are either at the local extrema or
at the boundaries (where we cannot even find critical points).

• So to find the minimum/maximum on some interval, compare the local min/max to the
value of the function at the interval’s endpoints. So, e.g., if the interval is (−∞,+∞),
check the function’s limits as it approaches −∞ and +∞.

Let’s try this last step for our example above, 𝑦 = 1
2
𝑥3 + 3𝑥2 − 2, to get the global extrema in

the entire domain.

INFO Exercise

Identify the global extrema of the function 𝑥3

3
− 3

2
𝑥2 − 10𝑥 in the interval [−6, 6].

4.3 Integrals

Informally, we can think of integrals as the flip side of derivatives.

We can motivate integrals as a way of finding the area under a curve. Sometimes finding the
area is easy. What’s the area under the curve between 𝑥 = −1 and 𝑥 = 1 for this function?
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𝑓(𝑥) = {
1
3 for 𝑥 ∈ [0, 3]
0 otherwise

Normally, finding the area under a curve is much harder. But this is basically the question
behind integration.

4.3.1 Integrals are about infinitesimals too

Let’s say we have a function 𝑦 = 𝑥2 And we want to find the area under the curve from 𝑥 = 0
to 𝑥 = 1. How would we do this?

ggplot() +
# draw main function
stat_function(fun = function(x){x ^ 2}, xlim = c(-2, 2)) +
# fill area under the curve between x = 0 and x = 1
geom_area(mapping = aes(x = 0), stat = "function",

fun = function(x){x ^ 2}, xlim = c(0, 1), fill = "red")
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One way to approximate this area is by drawing narrow rectangles that cover the area in red.
Let’s draw this on the board.

Our approximation is rough, but it gets better and better the narrower the rectangles are:
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𝐴𝑟𝑒𝑎 = 𝑙𝑖𝑚Δ𝑥→0

𝑛
∑

𝑖
𝑓(𝑥) ⋅ Δ𝑥

, where Δ𝑥 is the width of the rectangles and 𝑛 is their number.

This is actually one way to define the definite integral, ∫
𝑏

𝑎
𝑓(𝑥)𝑑𝑥 (also known as the Riemann

integral). We’ll learn how to compute these in a few moments.

4.3.2 Indefinite integrals as antiderivatives

The indefinite integral, also known as the antiderivative, 𝐹(𝑥) is the inverse of the function
𝑓 ′(𝑥).

𝐹(𝑥) = ∫𝑓(𝑥) 𝑑𝑥

This means if you take the derivative of 𝐹(𝑥), you wind up back at 𝑓(𝑥).

𝐹 ′ = 𝑓 or 𝑑𝐹(𝑥)
𝑑𝑥

= 𝑓(𝑥)

For example, what is the antiderivative for a constant function 𝑓(𝑥) = 1? Is there just one?
(this example comes from Moore and Siegel, 2013, p. 137).

This process is called anti-differentiation. We can use this concept to help us solve definite
integrals!

4.3.3 Solving definite integrals

One way to calculate definite integrals, known as the “fundamental theorem of calculus,” is
shown below:

∫
𝑏

𝑎
𝑓(𝑥) 𝑑𝑥 = 𝐹(𝑏) − 𝐹(𝑎) = 𝐹(𝑥)∣

𝑏

𝑎

First we determine the antiderivative (indefinite integral) of 𝑓(𝑥) (and represent it 𝐹(𝑥)),
substitute the upper limit first and then the lower limit one by one, and subtract the results in
order.
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Exclamation-Triangle Warning

𝐶 in the following definitions and rules is the called the “constant of integration.” We
need to add it when we define all antiderivatives (integrals) of a function because the
anti-derivative “undoes” the derivative.
Remember that the derivative of any constant is zero. So if we find an integral 𝐹(𝑥)
whose derivative is 𝑓(𝑥), adding (or subtracting) any constant will give us another integral
𝐹(𝑥) + 𝐶 whose derivative is also 𝑓(𝑥).

4.3.4 Rules of integration

Many of the rules of integetration have counterparts in differentiation.

Coefficient rule: ∫𝑐𝑓(𝑥) 𝑑𝑥 = 𝑐∫𝑓(𝑥) 𝑑𝑥

Sum/difference rule: ∫(𝑓(𝑥) ± 𝑔(𝑥)) 𝑑𝑥 = ∫𝑓(𝑥) 𝑑𝑥 ±∫𝑔(𝑥) 𝑑𝑥

Constant rule: ∫𝑐𝑑𝑥 = 𝑐𝑥 + 𝐶

Power rule: ∫𝑥𝑛 𝑑𝑥 = 𝑥𝑛+1

𝑛 + 1
+ 𝐶 ∀𝑛 ≠ −1

Reciprocal rule:∫ 1
𝑥
𝑑𝑥 = ln(𝑥) + 𝐶

Exponent and logarithm rules:

∫𝑒𝑥 𝑑𝑥 = 𝑒𝑥 +𝐶

∫𝑐𝑥 𝑑𝑥 = 𝑐𝑥

𝑙𝑛(𝑐)
+ 𝐶

∫𝑙𝑛(𝑥) 𝑑𝑥 = 𝑥 ⋅ 𝑙𝑛(𝑥) − 𝑥 + 𝐶

∫𝑙𝑜𝑔𝑐(𝑥) 𝑑𝑥 = 𝑥 ⋅ 𝑙𝑜𝑔𝑐(𝑥) − 𝑥
𝑙𝑜𝑔𝑐(𝑥)

+ 𝐶

The final two rules are analog to the product rule and the chain rule:

Integration by parts: ∫𝑓(𝑥)𝑔′(𝑥) 𝑑𝑥 = 𝑓(𝑥)𝑔(𝑥) −∫𝑓 ′(𝑥)𝑔(𝑥) 𝑑𝑥

Integration by substitution:
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1. Have ∫𝑓(𝑔(𝑥))𝑔′(𝑥) 𝑑𝑥

2. Set u=g(x)

3. Compute ∫𝑓(𝑢) 𝑑𝑢

4. Replace u for g(x)

Let’s do an example on the board: ∫𝑒𝑥22𝑥 𝑑𝑥.

4.3.5 Solving the problem

Remember our function 𝑦 = 𝑥2 and our goal of finding the area under the curve from 𝑥 = 0 to

𝑥 = 1. We can describe this problem as ∫
1

0
𝑥2𝑑𝑥

Find the indefinite integral, 𝐹(𝑥):

∫𝑥2 𝑑𝑥 = 𝑥3

3
+ 𝐶

Now we’ll use the fundamental theory of calculus. Evaluate at our lowest and highest points,
𝐹(0) and 𝐹(1):

• 𝐹(0) = 0

• 𝐹(1) = 1
3

• Technically 0 + 𝐶 and 1
3
+ 𝐶, but the C’s will fall out in the next step

Calculate 𝐹(1) − 𝐹(0)
1
3
− 0 = 1

3

INFO Exercise

Solve the following indefinite integrals:

1. ∫𝑥2 𝑑𝑥

2. ∫3𝑥2 𝑑𝑥

3. ∫𝑥 𝑑𝑥
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4. ∫(3𝑥2 + 2𝑥 − 7 )𝑑𝑥

5. ∫ 2
𝑥

𝑑𝑥

And solve the following definite integrals:

1. ∫
7

1
𝑥2 𝑑𝑥

2. ∫
10

1
3𝑥2 𝑑𝑥

3. ∫
7

7
𝑥 𝑑𝑥

4. ∫
5

1
3𝑥2 + 2𝑥 − 7 𝑑𝑥

5. ∫𝑒
1

2
𝑥

𝑑𝑥
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5 Tidy data analysis II

In this session, we’ll cover a few more advanced topics related to data wrangling. Again we’ll
use the tidyverse:

library(tidyverse)

-- Attaching core tidyverse packages ------------------------ tidyverse 2.0.0 --
v dplyr 1.2.0 v readr 2.1.6
v forcats 1.0.1 v stringr 1.6.0
v ggplot2 4.0.2 v tibble 3.3.1
v lubridate 1.9.5 v tidyr 1.3.2
v purrr 1.2.1
-- Conflicts ------------------------------------------ tidyverse_conflicts() --
x dplyr::filter() masks stats::filter()
x dplyr::lag() masks stats::lag()
i Use the conflicted package (<http://conflicted.r-lib.org/>) to force all conflicts to become errors

5.1 Loading data in different formats.

In this module we will use cross-national data from the Quality of Government (QoG) project
(Dahlberg et al., 2023).

Notice how in the data/ folder we have multiple versions of the same dataset (a subset of the
QOG basic dataset): .csv (comma-separated values), .rds (R), .xlsx (Excel), .dta (Stata), and
.sav (SPSS).

5.1.1 CSV and R data files

We can use the read_csv() and read_rds() functions from the tidyverse1 to read the .csv
and .rds (R) data files:

1Technically, the read_csv() and read_rds() functions come from readr, one of the tidyverse constituent
packages.
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qog_csv <- read_csv("data/sample_qog_bas_ts_jan23.csv")

Rows: 1085 Columns: 8
-- Column specification --------------------------------------------------------
Delimiter: ","
chr (4): cname, ccodealp, region, ht_colonial
dbl (4): year, wdi_pop, vdem_polyarchy, vdem_corr

i Use `spec()` to retrieve the full column specification for this data.
i Specify the column types or set `show_col_types = FALSE` to quiet this message.

qog_rds <- read_rds("data/sample_qog_bas_ts_jan23.rds")

For reading files from other software (Excel, Stata, or SPSS), we need to load additional
packages. Luckily, they are automatically installed when one installs the tidyverse.

5.1.2 Excel data files

For Excel files (.xls or .xlsx files), the readxl package has a handy read_excel() function.

library(readxl)
qog_excel <- read_excel("data/sample_qog_bas_ts_jan23.xlsx")

LIGHTBULB Tip

Useful arguments of the read_excel() function include sheet =, which reads particular
sheets (specified via their positions or sheet names), and range =, which extracts a
particular cell range (e.g., ‘A5:E25‘).

5.1.3 Stata and SPSS data files

To load files from Stata (.dta) or SPSS (.spss), one needs the haven package and its properly-
named read_stata() and read_spss() functions:

library(haven)
qog_stata <- read_stata("data/sample_qog_bas_ts_jan23.dta")
qog_spss <- read_spss("data/sample_qog_bas_ts_jan23.sav")
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LIGHTBULB Tip

Datasets from Stata and SPSS can have additional properties, like variable labels and
special types of missing values. To learn more about this, check out the “Labelled data”
chapter from Danny Smith’s Survey Research Datasets and R (2020).

5.1.4 Our data for this session

We will rename one of our objects to qog:

qog <- qog_csv
qog

# A tibble: 1,085 x 8
cname ccodealp year region wdi_pop vdem_polyarchy vdem_corr ht_colonial
<chr> <chr> <dbl> <chr> <dbl> <dbl> <dbl> <chr>

1 Antigua a~ ATG 1990 Carib~ 63328 NA NA British
2 Antigua a~ ATG 1991 Carib~ 63634 NA NA British
3 Antigua a~ ATG 1992 Carib~ 64659 NA NA British
4 Antigua a~ ATG 1993 Carib~ 65834 NA NA British
5 Antigua a~ ATG 1994 Carib~ 67072 NA NA British
6 Antigua a~ ATG 1995 Carib~ 68398 NA NA British
7 Antigua a~ ATG 1996 Carib~ 69798 NA NA British
8 Antigua a~ ATG 1997 Carib~ 71218 NA NA British
9 Antigua a~ ATG 1998 Carib~ 72572 NA NA British
10 Antigua a~ ATG 1999 Carib~ 73821 NA NA British
# i 1,075 more rows

This dataset is a small sample of QOG, which contains data for countries in the Americas from
1990 to 2020. The observational unit is thus country-year. You can access the full codebook
online. The variables are as follows:

Variable Description

cname Country name
ccodealp Country code (ISO-3 character convention)
year Year
region Region (following legacy WDI convention). Added to QOG by us.
wdi_pop Total population, from the World Development Indicators
vdem_polyarchy V-Dem’s polyarchy index (electoral democracy)
vdem_corr V-Dem’s corruption index
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Variable Description

ht_colonial Former colonial ruler

5.2 Recoding variables

Take a look at the ht_colonial variable. We can do a simple tabulation with count():

qog |>
count(ht_colonial)

# A tibble: 6 x 2
ht_colonial n
<chr> <int>

1 British 372
2 Dutch 31
3 French 31
4 Never colonized 62
5 Portuguese 31
6 Spanish 558

LIGHTBULB Tip

Another common way to compute quick tabulations in R is with the table() function.
Be aware that this takes a vector as the input:

table(qog$ht_colonial)

British Dutch French Never colonized Portuguese
372 31 31 62 31

Spanish
558

We might want to recode this variable. For instance, we could create a dummy/binary variable
for whether the country was a British colony. We can do this with if_else(), which works
with logical conditions:
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qog |>
# the arguments are condition, true (what to do if true), false
mutate(d_britishcol = if_else(ht_colonial == "British", 1, 0)) |>
count(d_britishcol)

# A tibble: 2 x 2
d_britishcol n

<dbl> <int>
1 0 713
2 1 372

Instead of a numeric classification (0 and 1), we could use characters:

qog |>
mutate(cat_britishcol = if_else(ht_colonial == "British", "British", "Other")) |>
count(cat_britishcol)

# A tibble: 2 x 2
cat_britishcol n
<chr> <int>

1 British 372
2 Other 713

if_else() is great for binary recoding. But sometimes we want to create more than two
categories. We can use case_when():

qog |>
# syntax is condition ~ value
mutate(cat_col = case_when(

ht_colonial == "British" ~ "British",
ht_colonial == "Spanish" ~ "Spanish",
.default = "Other" # what to do in all other cases

)) |>
count(cat_col)

# A tibble: 3 x 2
cat_col n
<chr> <int>

1 British 372
2 Other 155
3 Spanish 558
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The .default = argument in case_when() can also be used to leave the variable as-is for
non-specified cases. For example, let’s combine Portuguese and Spanish colonies:

qog |>
# syntax is condition ~ value
mutate(cat_col = case_when(

ht_colonial %in% c("Spanish", "Portuguese") ~ "Spanish/Portuguese",
.default = ht_colonial # what to do in all other cases

)) |>
count(cat_col)

# A tibble: 5 x 2
cat_col n
<chr> <int>

1 British 372
2 Dutch 31
3 French 31
4 Never colonized 62
5 Spanish/Portuguese 589

INFO Exercise

1. Create a dummy variable, d_large_pop, for whether the country-year has a popu-
lation of more than 1 million. Then compute its mean. Your code:

2. Which countries are recorded as “Never colonized”? Change their values to other
reasonable codings and compute a tabulation with count(). Your code:

5.3 Missing values

Missing values are commonplace in real datasets. In R, missing values are a special type of
value in vectors, denoted as NA.

Exclamation-Triangle Warning

The special value NA is different from the character value “NA”. For example, notice that
a numeric vector can have NAs, while it obviously cannot hold the character value “NA”:

c(5, 4.6, NA, 8)

[1] 5.0 4.6 NA 8.0
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A quick way to check for missing values in small datasets is with the summary() function:

summary(qog)

cname ccodealp year region
Length:1085 Length:1085 Min. :1990 Length:1085
Class :character Class :character 1st Qu.:1997 Class :character
Mode :character Mode :character Median :2005 Mode :character

Mean :2005
3rd Qu.:2013
Max. :2020

wdi_pop vdem_polyarchy vdem_corr ht_colonial
Min. : 40542 Min. :0.0710 Min. :0.0260 Length:1085
1st Qu.: 389131 1st Qu.:0.5570 1st Qu.:0.1890 Class :character
Median : 5687744 Median :0.7030 Median :0.5550 Mode :character
Mean : 25004057 Mean :0.6569 Mean :0.4922
3rd Qu.: 16195902 3rd Qu.:0.8030 3rd Qu.:0.7540
Max. :331501080 Max. :0.9160 Max. :0.9630

NA's :248 NA's :248

Notice that we have missingness in the vdem_polyarchy and vdem_corr variables. We might
want to filter the dataset to see which observations are in this situation:

qog |>
filter(vdem_polyarchy == NA | vdem_corr == NA)

# A tibble: 0 x 8
# i 8 variables: cname <chr>, ccodealp <chr>, year <dbl>, region <chr>,
# wdi_pop <dbl>, vdem_polyarchy <dbl>, vdem_corr <dbl>, ht_colonial <chr>

But the code above doesn’t work! To refer to missing values in logical conditions, we cannot
use == NA. Instead, we need to use the is.na() function:

qog |>
filter(is.na(vdem_polyarchy) | is.na(vdem_corr))

# A tibble: 248 x 8
cname ccodealp year region wdi_pop vdem_polyarchy vdem_corr ht_colonial
<chr> <chr> <dbl> <chr> <dbl> <dbl> <dbl> <chr>
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1 Antigua a~ ATG 1990 Carib~ 63328 NA NA British
2 Antigua a~ ATG 1991 Carib~ 63634 NA NA British
3 Antigua a~ ATG 1992 Carib~ 64659 NA NA British
4 Antigua a~ ATG 1993 Carib~ 65834 NA NA British
5 Antigua a~ ATG 1994 Carib~ 67072 NA NA British
6 Antigua a~ ATG 1995 Carib~ 68398 NA NA British
7 Antigua a~ ATG 1996 Carib~ 69798 NA NA British
8 Antigua a~ ATG 1997 Carib~ 71218 NA NA British
9 Antigua a~ ATG 1998 Carib~ 72572 NA NA British
10 Antigua a~ ATG 1999 Carib~ 73821 NA NA British
# i 238 more rows

Notice that, in most R functions, missing values are “contagious.” This means that any missing
value will contaminate the operation and carry over to the results. For example:

qog |>
summarize(mean_vdem_polyarchy = mean(vdem_polyarchy))

# A tibble: 1 x 1
mean_vdem_polyarchy

<dbl>
1 NA

Sometimes we’d like to perform our operations even in the presence of missing values, simply
excluding them. Most basic R functions have an na.rm = argument to do this:

qog |>
summarize(mean_vdem_polyarchy = mean(vdem_polyarchy, na.rm = T))

# A tibble: 1 x 1
mean_vdem_polyarchy

<dbl>
1 0.657

INFO Exercise

Calculate the median value of the corruption variable for each region (i.e., perform a
grouped summary). Your code:

94



5.4 Pivoting data

We will now load another time-series cross-sectional dataset, but in a slightly different format.
It’s adapted from the World Bank’s World Development Indicators (WDI) (2023) and records
gross domestic product at purchasing power parity (GDP PPP).

gdp <- read_excel("data/wdi_gdp_ppp.xlsx")

gdp

# A tibble: 266 x 35
country_name country_code `1990` `1991` `1992` `1993` `1994`
<chr> <chr> <dbl> <dbl> <dbl> <dbl> <dbl>

1 Aruba ABW 2.03e 9 2.19e 9 2.32e 9 2.48e 9 2.69e 9
2 Africa Eastern and~ AFE 9.41e11 9.42e11 9.23e11 9.19e11 9.35e11
3 Afghanistan AFG NA NA NA NA NA
4 Africa Western and~ AFW 5.76e11 5.84e11 5.98e11 5.92e11 5.91e11
5 Angola AGO 6.85e10 6.92e10 6.52e10 4.95e10 5.02e10
6 Albania ALB 1.59e10 1.14e10 1.06e10 1.16e10 1.26e10
7 Andorra AND NA NA NA NA NA
8 Arab World ARB 2.19e12 2.25e12 2.35e12 2.41e12 2.48e12
9 United Arab Emirat~ ARE 2.01e11 2.03e11 2.10e11 2.12e11 2.27e11
10 Argentina ARG 4.61e11 5.04e11 5.43e11 5.88e11 6.22e11
# i 256 more rows
# i 28 more variables: `1995` <dbl>, `1996` <dbl>, `1997` <dbl>, `1998` <dbl>,
# `1999` <dbl>, `2000` <dbl>, `2001` <dbl>, `2002` <dbl>, `2003` <dbl>,
# `2004` <dbl>, `2005` <dbl>, `2006` <dbl>, `2007` <dbl>, `2008` <dbl>,
# `2009` <dbl>, `2010` <dbl>, `2011` <dbl>, `2012` <dbl>, `2013` <dbl>,
# `2014` <dbl>, `2015` <dbl>, `2016` <dbl>, `2017` <dbl>, `2018` <dbl>,
# `2019` <dbl>, `2020` <dbl>, `2021` <dbl>, `2022` <dbl>

Note how the information is recorded differently. Here columns are not variables, but years.
We call datasets like this one wide, in contrast to the long datasets we have seen before. In
general, R and the tidyverse work much nicer with long datasets. Luckily, the tidyr package
of the tidyverse makes it easy to convert datasets between these two formats.
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Figure 5.1: Source: Illustration by Allison Horst, adapted by Peter Higgins.

We will use the pivot_longer() function:

gdp_long <- gdp |>
pivot_longer(cols = -c(country_name, country_code), # cols to not pivot

names_to = "year", # how to name the column with names
values_to = "wdi_gdp_ppp", # how to name the column with values

96

https://github.com/allisonhorst/stats-illustrations
https://github.com/allisonhorst/stats-illustrations/issues/6


names_transform = as.integer) # make sure that years are numeric
gdp_long

# A tibble: 8,778 x 4
country_name country_code year wdi_gdp_ppp
<chr> <chr> <int> <dbl>

1 Aruba ABW 1990 2025472682.
2 Aruba ABW 1991 2186758474.
3 Aruba ABW 1992 2315391348.
4 Aruba ABW 1993 2484593045.
5 Aruba ABW 1994 2688426606.
6 Aruba ABW 1995 2756904694.
7 Aruba ABW 1996 2789595753.
8 Aruba ABW 1997 2986175079.
9 Aruba ABW 1998 3045659222.
10 Aruba ABW 1999 3083365758.
# i 8,768 more rows

Done! This is a much friendlier format to work with. For example, we can now do summaries:

gdp_long |>
summarize(mean_gdp_ppp = mean(wdi_gdp_ppp, na.rm = T), .by = country_name)

# A tibble: 266 x 2
country_name mean_gdp_ppp
<chr> <dbl>

1 Aruba 3.38e 9
2 Africa Eastern and Southern 1.61e12
3 Afghanistan 5.56e10
4 Africa Western and Central 1.15e12
5 Angola 1.38e11
6 Albania 2.56e10
7 Andorra NaN
8 Arab World 4.22e12
9 United Arab Emirates 4.29e11
10 Argentina 8.06e11
# i 256 more rows
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INFO Exercise

Convert back gdp_long to a wide format using pivot_wider(). Check out the help file
using ?pivot_wider. Your code:

5.5 Merging datasets

It is extremely common to want to integrate data from multiple sources. Combining information
from two datasets is called merging or joining.

To do this, we need ID variables in common between the two data sets. Using our QOG and
WDI datasets, these variables will be country code (which in this case is shared between the
two datasets) and year.

LIGHTBULB Tip

Standardized unit codes (like country codes) are extremely useful when merging data.
It’s harder than expected for a computer to realize that “Bolivia (Plurinational State of)”
and “Bolivia” refer to the same unit. By default, these units will not be matched.2

Okay, now to the merging. Imagine we want to add information about GDP to our QOG
main dataset. To do so, we can use the left_join() function, from the tidyverse’s dplyr
package:

qog_plus <- left_join(qog, # left data frame, which serves as a "base"
gdp_long, # right data frame, from which to draw new columns
by = c("ccodealp" = "country_code", # can define name equivalencies!

"year"))

qog_plus |>
# select variables for clarity
select(cname, ccodealp, year, wdi_pop, wdi_gdp_ppp)

# A tibble: 1,085 x 5
cname ccodealp year wdi_pop wdi_gdp_ppp
<chr> <chr> <dbl> <dbl> <dbl>

1 Antigua and Barbuda ATG 1990 63328 966660878.

2There are R packages to deal with these complications. fuzzyjoin matches units by their approximate
distance, using some clever algorithms. countrycode allows one to standardize country names and country
codes across different conventions.
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2 Antigua and Barbuda ATG 1991 63634 987701012.
3 Antigua and Barbuda ATG 1992 64659 999143284.
4 Antigua and Barbuda ATG 1993 65834 1051896837.
5 Antigua and Barbuda ATG 1994 67072 1122128908.
6 Antigua and Barbuda ATG 1995 68398 1073208718.
7 Antigua and Barbuda ATG 1996 69798 1144088355.
8 Antigua and Barbuda ATG 1997 71218 1206688391.
9 Antigua and Barbuda ATG 1998 72572 1263778328.
10 Antigua and Barbuda ATG 1999 73821 1310634399.
# i 1,075 more rows

LIGHTBULB Tip

Most of the time, you’ll want to do a left_join(), which is great for adding new
information to a “base” dataset, without dropping information from the latter. In limited
situations, other types of joins can be helpful. To learn more about them, you can read
Jenny Bryan’s excellent tutorial on dplyr joins.

INFO Exercise

There is a dataset on country’s CO2 emissions, again from the World Bank (2023), in
“data/wdi_co2.csv”. Load the dataset into R and add a new variable with its information,
wdi_co2, to our qog_plus data frame. Finally, compute the average values of CO2
emissions per capita, by country. Tip: this exercise requires you to do many steps—plan
ahead before you start coding! Your code:

5.5.1 Sanity checks

Sanity checks are small tests to make sure that your code is doing what you think it’s doing.
They are especially important in complex operations like joins, but the idea can be extended
to pretty much any command.

The tidylog package gives more information about tidyverse operations, and it’s an easy/au-
tomatic way to check your work:

library(tidylog)

qog_plus <- left_join(qog, # left data frame, which serves as a "base"
gdp_long, # right data frame, from which to draw new columns
by = c("ccodealp" = "country_code", # can define name equivalencies!

"year"))
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left_join: added 2 columns (country_name, wdi_gdp_ppp)
> rows only in qog 0
> rows only in gdp_long (7,693)
> matched rows 1,085
> =======
> rows total 1,085

You can also construct sanity checks manually. For instance, we know that a left join shouldn’t
modify a data frame’s number of rows:

nrow(qog) == nrow(qog_plus)

[1] TRUE

5.6 Plotting extensions: trend graphs, facets, and customization

INFO Exercise

Draw a scatterplot with time in the x-axis and democracy scores in the y-axis. Your code:

How can we visualize trends effectively? One alternative is to use a trend graph. Let’s start by
computing the yearly averages for democracy in the whole region:

dem_yearly <- qog |>
summarize(mean_dem = mean(vdem_polyarchy, na.rm = T), .by = year)

summarize: now 31 rows and 2 columns, ungrouped

dem_yearly

# A tibble: 31 x 2
year mean_dem

<dbl> <dbl>
1 1990 0.581
2 1991 0.600
3 1992 0.605
4 1993 0.620
5 1994 0.629
6 1995 0.642
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7 1996 0.651
8 1997 0.657
9 1998 0.663
10 1999 0.661
# i 21 more rows

Now we can plot them with a scatterplot:

ggplot(dem_yearly, aes(x = year, y = mean_dem)) +
geom_point()
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We can add geom_line() to connect the dots:

ggplot(dem_yearly, aes(x = year, y = mean_dem)) +
geom_point() +
geom_line()
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We can, of course, remove to points to only keep the line:

ggplot(dem_yearly, aes(x = year, y = mean_dem)) +
geom_line()
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What if we want to plot trends for different countries? We can use the group and color
aesthetic mappings (no need to do a summary here! data is already at the country-year level):

# filter to only get Colombia and Venezuela
dem_yearly_countries <- qog |>
filter(ccodealp %in% c("COL", "VEN"))

filter: removed 1,023 rows (94%), 62 rows remaining

ggplot(dem_yearly_countries, aes(x = year, y = vdem_polyarchy, color = cname)) +
geom_line()
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Remember that we can use the labs() function to add labels:

ggplot(dem_yearly_countries, aes(x = year, y = vdem_polyarchy, color = cname)) +
geom_line() +
labs(x = "Year", y = "V-Dem Electoral Democracy Score", color = "Country",

title = "Evolution of democracy scores in Colombia and Venezuela",
caption = "Source: V-Dem (Coppedge et al., 2022) in QOG dataset.")
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Source: V−Dem (Coppedge et al., 2022) in QOG dataset.

Another way to display these trends is by using facets, which divide a plot into small boxes
according to a categorical variable (no need to add color here):

ggplot(dem_yearly_countries, aes(x = year, y = vdem_polyarchy)) +
geom_line() +
facet_wrap(~cname)
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Facets are particularly useful for many categories (where the number of distinguishable colors
reaches its limit):

ggplot(qog |> filter(region == "South America"),
aes(x = year, y = vdem_polyarchy)) +

geom_line() +
facet_wrap(~cname)

filter: removed 713 rows (66%), 372 rows remaining
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With facets, one can control whether each facet picks its own scales or if all facets share the
same scale. For example, let’s plot the populations of Canada and the US:

ggplot(qog |> filter(cname %in% c("Canada", "United States")),
aes(x = year, y = wdi_pop)) +

geom_line() +
facet_wrap(~cname)

filter: removed 1,023 rows (94%), 62 rows remaining
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The scales are so disparate that unifying them yields a plot that’s hard to interpret. But if
we’re interested in within-country trends, we can let each facet have its own scale with the
scales = argument (which can be “fixed”, “free_x”, “free_y”, or “free”):

ggplot(qog |> filter(cname %in% c("Canada", "United States")),
aes(x = year, y = wdi_pop)) +

geom_line() +
facet_wrap(~cname, scales = "free_y")

filter: removed 1,023 rows (94%), 62 rows remaining
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This ability to visualize within time trends also makes facets appealing in many situations.

LIGHTBULB Tip

Plots made with ggplot2 are extremely customizable. For example, we could want to
change the y-axis labels in the last plot to something more readable:

# create as object "p" to use later
p <- ggplot(qog |> filter(cname %in% c("Canada", "United States")),

aes(x = year, y = wdi_pop)) +
geom_line() +
facet_wrap(~cname, scales = "free_y") +
scale_y_continuous(labels = scales::label_number(big.mark = ",")) +
# also add labels
labs(x = "Year", y = "Population",

title = "Population trends in Canada and the United States",
caption = "Source: World Development Indicators (World Bank, 2023) in QOG dataset.")

filter: removed 1,023 rows (94%), 62 rows remaining

p
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Population trends in Canada and the United States

Source: World Development Indicators (World Bank, 2023) in QOG dataset.

While it’s impossible for us to review all the customization options you might need, a
fantastic reference is the “ggplot2: Elegant Graphics for Data Analysis” book by Hadley
Wickham, Danielle Navarro, and Thomas Lin Pedersen.

INFO Exercise

Using your merged dataset from the previous section, plot the trajectories of C02 per
capita emissions for the US and Haiti. Use adequate scales.

5.6.1 Themes

We can change the overall aspect of a ggplot2 figure by changing its theme:

p +
theme_minimal()
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Population trends in Canada and the United States

Source: World Development Indicators (World Bank, 2023) in QOG dataset.

p +
theme_classic()
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Population trends in Canada and the United States

Source: World Development Indicators (World Bank, 2023) in QOG dataset.
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p +
theme_bw()
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Population trends in Canada and the United States

Source: World Development Indicators (World Bank, 2023) in QOG dataset.

If you are going to make multiple plots in a script, you can set the theme at the beginning
with theme_bw():

theme_set(theme_bw())
p
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Population trends in Canada and the United States

Source: World Development Indicators (World Bank, 2023) in QOG dataset.
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6 Probability

6.1 What is probability?

• Informally, a probability is a number that describes how likely an event is.

– It is, by definition, between 0 and 1.
– What is the probability that a fair coin flip will result in heads?

• We can also think of a probability as an outcome’s relative frequency after repeating
an “experiment” many times.1

– In this setting, an experiment is “an action or a set of actions that produce stochastic
[random] events of interest” (Imai and Williams 2022, p. 281). Not to confuse with
scientific experiments!

– If we were to flip a million fair coins, what will be the proportion of heads?

• A probability space (Ω, 𝑆, 𝑃 ) is a formal way to talk about a random process:

– The sample space (Ω) is the set of all possible outcomes.
– The event space (𝑆) is a collection of events (an event is a subset of Ω).
– The probability measure (𝑃) is a function that assigns a probability in ℝ to every

event in 𝑆. So 𝑃 ∶ 𝑆 → ℝ.

• We can formalize our intuitions with the probability axioms (sometimes called Kol-
mogorov’s axioms):

– 𝑃(𝐴) ≥ 0, ∀𝐴 ∈ 𝑆.
∗ Probabilities must be non-negative.

– 𝑃(Ω) = 1.
∗ Something has to happen!
∗ Probabilities sum/integrate to 1.

– 𝑃(𝐴 ∪ 𝐵) = 𝑃(𝐴) + 𝑃(𝐵), ∀𝐴,𝐵 ∈ 𝑆, 𝐴 ∪ 𝐵 = ∅.
∗ The probability of disjoint (mutually exclusive) events is equal to the sum of

their individual probabilities.

1This is sometimes called the frequentist interpretation of probability. There are other possibilities, such as
Bayesian interpretations of probability, which describe probabilities as degrees of belief.
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6.2 Definitions and properties of probability

• Joint probability: 𝑃(𝐴 ∩ 𝐵). The probability that the two events will occur in one
realization of the experiment.

• Law of total probability: 𝑃(𝐴) = 𝑃(𝐴 ∩ 𝐵) + 𝑃(𝐴 ∩ 𝐵𝐶).

• Addition rule: 𝑃(𝐴 ∪ 𝐵) = 𝑃(𝐴) + 𝑃(𝐵) − 𝑃(𝐴 ∩ 𝐵).

• Conditional probability: 𝑃(𝐴|𝐵) = 𝑃(𝐴 ∩ 𝐵)
𝑃(𝐵)

– the probability of event 𝐴 occurring given that event 𝐵 has already occurred is the
probability that both 𝐴 and 𝐵 occur together devided by the probability that event
𝐵 occurs

• Bayes theorem: 𝑃(𝐴|𝐵) = 𝑃(𝐴) ⋅ 𝑃 (𝐵|𝐴)
𝑃(𝐵)

– 𝑃(𝐴|𝐵): the probability of event A occurring given that B is true
– 𝑃(𝐵|𝐴): the probability of event B occurring given that A is true.

6.3 Random variables and probability distributions

• A random variable is a function (𝑋 ∶ Ω → ℝ) of the outcome of a random generative
process. Informally, it is a “placeholder” for whatever will be the output of a process
we’re studying.

• A probability distribution describes the probabilities associated with the values of a
random variable.

• Random variables (and probability distributions) can be discrete or continuous.

6.3.1 Discrete random variables and probability distributions

• A sample space in which there are a (finite or infinite) countable number of outcomes

• Each realization of random process has a discrete probability of occurring.

– 𝑓(𝑋 = 𝑥𝑖) = 𝑃(𝑋 = 𝑥𝑖) is the probability the variable takes the value 𝑥𝑖.
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An example

• What’s the probability that we’ll roll a 3 on one die roll:

𝑃𝑟(𝑦 = 3) = 1
6

• If one roll of the die is an “experiment,” we can think of a 3 as a “success.”

• 𝑌 ∼ 𝐵𝑒𝑟𝑛𝑜𝑢𝑙𝑙𝑖 (1
6)

• Fair coins are ∼ 𝐵𝑒𝑟𝑛𝑜𝑢𝑙𝑙𝑖(.5), for example.

• More generally, 𝐵𝑒𝑟𝑛𝑜𝑢𝑙𝑙𝑖(𝜋). We’ll talk about other probability distributions soon.

– 𝜋 represents the probability of success.

Let’s do another example on the board, using the sum of two fair dice.

LIGHTBULB Exercise:

What’s the probability that the sum of two fair dice equals 7?

6.3.2 Continuous random variables and probability distributions

• What happens when our outcome is continuous?
• There are an infinite number of outcomes. This makes the denominator of our fraction

difficult to work with.
• The probability of the whole space must equal 1.
• The domain may not span -∞ to ∞.

– Even space between 0 and 1 is infinite!

• Two common examples are the uniform and normal probability distributions, which we
will discuss below.

6.4 Functions describing probability distributions

6.4.1 Probability Mass Function (PMF) – Discrete Variables

Probability of each occurrence encoded in probability mass function (PMF)

• 0 ≤ 𝑓(𝑥𝑖) ≤ 1: Probability of any value occurring must be between 0 and 1.
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• ∑
𝑥

𝑓(𝑥𝑖) = 1: Probabilities of all values must sum to 1.

6.4.2 Probability Density Function (PDF) – Continuous Variables

• Similar to PMF from before, but for continuous variables.

• Using integration, it gives the probability a value falls within a particular interval

𝑃 [𝑎 ≤ 𝑋 ≤ 𝑏] = ∫
𝑏

𝑎
𝑓(𝑥) 𝑑𝑥

• Total area under the curve is 1.

• 𝑃(𝑎 < 𝑋 < 𝑏) is the area under the curve between 𝑎 and 𝑏 (where 𝑏 > 𝑎).
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Figure 6.1: Box plot and PDF of a normal distribution 𝑁(0, 𝜎2)

Source: Wikipedia Commons
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6.4.3 Cumulative Density Function (CDF)

Discrete

• Cumulatve density function is probability X will take a value of x or lower.
• PDF is written 𝑓(𝑥), and CDF is written 𝐹 ′(𝑥).

𝐹𝑋(𝑥) = 𝑃𝑟(𝑋 ≤ 𝑥)

• For discrete CDFs, that means summing up over all values.

LIGHTBULB Exercise:

What is the probability of rolling a 6 or lower with two dice? 𝐹(6) = ?

Continuous

• We can’t sum probabilities for continuous distributions (remember the 0 problem).
• Solution: integration

𝐹𝑌(𝑦) = ∫
𝑦

−∞
𝑓(𝑦)𝑑𝑦

• Examples of uniform distribution.

6.5 Common types of probability distributions

There are many useful probability distributions. In this section we will cover three of the most
common ones: the binomial, uniform, and normal distributions.

6.5.1 Binomial distribution

A Binomial distribution is defined as follow: 𝑋 ∼ 𝐵𝑖𝑛𝑜𝑚𝑖𝑎𝑙(𝑛, 𝑝)

PMF:

(𝑛
𝑘
)𝑝𝑘(1 − 𝑝)𝑛−𝑘

, where 𝑛 is the number of trials, 𝑝 is the probability of success, and 𝑘 is the number of
successes.

Remember that:
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(𝑛
𝑘
) = 𝑛!

𝑘!(𝑛 − 𝑘)!

For example, let’s say that voters choose some candidate with probability 0.02. What is the
probability of seeing exactly 0 voters of the candidate in a sample of 100 people?

We can compute the PMF of a binomial distribution using R’s dbinom() function.

dbinom(x = 0, size = 100, prob = 0.02)

[1] 0.1326196

dbinom(x = 1, size = 100, prob = 0.02)

[1] 0.2706522

Similarly, we can compute the CDF using R’s pbinom() function:

pbinom(q = 0, size = 100, prob = 0.02)

[1] 0.1326196

pbinom(q = 100, size = 100, prob = 0.02)

[1] 1

pbinom(q = 1, size = 100, prob = 0.02)

[1] 0.4032717

INFO Exercise

Compute the probability of seeing between 1 and 10 voters of the candidate in a sample
of 100 people.
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6.5.2 Uniform distribution

A uniform distribution has two parameters: a minimum and a maximum. So 𝑋 ∼ 𝑈(𝑎, 𝑏).

• PDF:

{
1

𝑏−𝑎 , 𝑥 ∈ [𝑎, 𝑏]
0 , otherwise

• CDF:

⎧{
⎨{⎩

0 , 𝑥 < 𝑎
𝑥−𝑎
𝑏−𝑎 , 𝑥 ∈ [𝑎, 𝑏]
1 , 𝑥 > 𝑏

In R, dunif() gives the PDF of a uniform distribution. By default, it is 𝑋 ∼ 𝑈(0, 1).

library(tidyverse)

ggplot() +
stat_function(fun = dunif, xlim = c(-4, 4))
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Meanwhile, punif() evaluates the CDF of a uniform distribution.

punif(q = .3)

[1] 0.3

INFO Exercise

Evaluate the CDF of 𝑌 ∼ 𝑈(−2, 2) at point 𝑦 = 1. Use the formula and punif().

6.5.3 Normal distribution

A normal distribution has two parameters: a mean and a standard deviation. So 𝑋 ∼ 𝑁(𝜇, 𝜎).

• PDF: 2 1
𝜎
√
2𝜋

𝑒− 1
2 ( 𝑥−𝜇

𝜎 )2

In R, dnorm() gives us the PDF of a standard normal distribution (𝑍 ∼ 𝑁(0, 1)):

ggplot() +
stat_function(fun = dnorm, xlim = c(-4, 4))

0.0

0.1

0.2

0.3

0.4

−4 −2 0 2 4
x

y

122



Like you might expect, pnorm() computes the CDF of a normal distribution (by default, the
standard normal).

pnorm(0)

[1] 0.5

pnorm(1) - pnorm(-1)

[1] 0.6826895

INFO Exercise

What is the probability of obtaining a value above 1.96 or below -1.96 in a standard
normal probability distribution? Hint: use the pnorm() function.
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7 Statistics and simulations

library(tidyverse)

7.1 Random sampling

Before we jump to statistics and simulations, we’ll cover how to do random sampling in R.

7.1.1 Random sampling from theoretical distributions

Uniform distribution

For the uniform distribution, the arguments specify how many draws we want and the bound-
aries

runif(n = 20, min = -3, max = 3)

[1] -1.137758941 2.392921769 0.129632063 -2.290173730 -1.062591418
[6] 2.781400303 2.181763023 0.106198983 0.682123094 2.887364182
[11] -0.714150290 -1.048176593 2.684431935 -1.671780896 0.002257003
[16] -0.189859270 2.667299878 -2.389467512 -1.420555795 0.521813369

When we draw a million times from the distribution, we can then plot it and see that it does
look as we would expect:

set.seed(123)
my_runif <- runif(n = 1000000, min = -3, max = 3)

ggplot(data.frame(my_runif), aes(x = my_runif)) +
geom_histogram(binwidth = 0.25, boundary = 0, closed = "right") +
scale_x_continuous(breaks = seq(-5, 5, 1), limits = c(-5, 5))
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Binomial distribution

For the binomial distribution, we can specify the number of draws, how many trials each draw
will have, and the probability of success.

For instance, we can ask R to do the following twenty times: flip a fair coin one hundred times,
and count the number of tails.

rbinom(n = 20, size = 100, prob = 0.5)

[1] 48 45 54 50 58 50 42 58 48 57 53 49 52 51 49 40 57 53 52 41

With prob = , we can implement unfair coins:

rbinom(n = 20, size = 100, prob = 0.9)

[1] 88 87 93 95 93 92 91 94 87 91 90 92 93 89 90 95 91 90 86 88
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Normal distribution

For the Normal or Gaussian distribution, we specify the number of draws, the mean, and
standard deviation:

rnorm(n = 20, mean = 0, sd = 1)

[1] 1.10455864 0.06386693 -1.59684275 1.86298270 -0.90428935 -1.55158044
[7] 1.27986282 -0.32420495 -0.70015076 2.17271578 0.89778913 -0.01338538
[13] -0.74074395 0.36772316 -0.66453402 -1.11498344 -1.15067439 -0.55098894
[19] 0.10503154 -0.27183645

INFO Exercise

Compute and plot my_rnorm, a vector with 10,000 draws from a Normal distribution 𝑋
with mean equal to -10 and standard deviation equal to 2 (𝑋 ∼ 𝑁(−10, 2)). You can
recycle code!

7.1.2 Random sampling from data

In this section we will work with good ol’ mtcars, one of R’s most notable default datasets.
We’ll assign it to an object so it shows in our Environment pane:

my_mtcars <- mtcars

LIGHTBULB Tip

Default datasets such as mtcars and iris are useful because they are available to everyone,
and once you become familiar with them, you can start thinking about the code instead
of the intricacies of the data. These qualities also make default datasets ideal for building
reproducible examples (see Wickham 2014)

We can use the function sample() to obtain random values from a vector. The size = argument
specifies how many values we want. For example, let’s get one random value of the “mpg”
column:

sample(my_mtcars$mpg, size = 1)

[1] 24.4

126

http://adv-r.had.co.nz/Reproducibility.html


Every time we run this command, we can get a different result:

sample(my_mtcars$mpg, size = 1)

[1] 14.7

sample(my_mtcars$mpg, size = 1)

[1] 15.5

In some occasions we do want to get the same result consistently after running some random
process multiple times. In this case, we set a seed, which takes advantage of R’s pseudo-random
number generator capabilities. No matter how many times we run the following code block,
the result will be the same:

set.seed(123)
sample(my_mtcars$mpg, size = 1)

[1] 15

Sampling with replacement means that we can get the same value multiple times. For example:

set.seed(12)
sample(c("Banana", "Apple", "Orange"), size = 3, replace = T)

[1] "Apple" "Apple" "Orange"

sample(my_mtcars$mpg, size = 100, replace = T)

[1] 26.0 15.2 18.7 18.7 30.4 21.0 24.4 26.0 32.4 15.8 32.4 19.2 18.1 16.4 19.2
[16] 27.3 14.3 10.4 17.3 13.3 21.4 13.3 19.2 24.4 15.0 27.3 17.8 15.2 15.8 14.3
[31] 19.7 16.4 18.7 15.8 19.2 21.0 14.3 15.2 14.3 27.3 21.4 33.9 33.9 21.4 30.4
[46] 33.9 21.4 17.3 17.3 10.4 26.0 18.7 15.2 30.4 10.4 10.4 15.5 14.3 26.0 17.3
[61] 33.9 26.0 24.4 18.7 30.4 32.4 21.5 30.4 15.2 27.3 13.3 17.3 21.4 24.4 13.3
[76] 22.8 33.9 13.3 21.5 14.3 19.2 30.4 24.4 26.0 15.8 10.4 24.4 14.3 15.2 10.4
[91] 19.2 21.0 16.4 19.2 24.4 19.7 18.7 10.4 18.7 17.8

In order to sample not from a vector but from a data frame’s rows, we can use the
slice_sample() function from dplyr:
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my_mtcars |>
slice_sample(n = 2) # a number of rows

mpg cyl disp hp drat wt qsec vs am gear carb
Dodge Challenger 15.5 8 318 150 2.76 3.52 16.87 0 0 3 2
Datsun 710 22.8 4 108 93 3.85 2.32 18.61 1 1 4 1

my_mtcars |>
slice_sample(prop = 0.5) # a proportion of rows

mpg cyl disp hp drat wt qsec vs am gear carb
Toyota Corolla 33.9 4 71.1 65 4.22 1.835 19.90 1 1 4 1
Ferrari Dino 19.7 6 145.0 175 3.62 2.770 15.50 0 1 5 6
Merc 450SE 16.4 8 275.8 180 3.07 4.070 17.40 0 0 3 3
Hornet Sportabout 18.7 8 360.0 175 3.15 3.440 17.02 0 0 3 2
Maserati Bora 15.0 8 301.0 335 3.54 3.570 14.60 0 1 5 8
Datsun 710 22.8 4 108.0 93 3.85 2.320 18.61 1 1 4 1
Ford Pantera L 15.8 8 351.0 264 4.22 3.170 14.50 0 1 5 4
Dodge Challenger 15.5 8 318.0 150 2.76 3.520 16.87 0 0 3 2
Merc 280 19.2 6 167.6 123 3.92 3.440 18.30 1 0 4 4
Lincoln Continental 10.4 8 460.0 215 3.00 5.424 17.82 0 0 3 4
Valiant 18.1 6 225.0 105 2.76 3.460 20.22 1 0 3 1
Fiat 128 32.4 4 78.7 66 4.08 2.200 19.47 1 1 4 1
Mazda RX4 Wag 21.0 6 160.0 110 3.90 2.875 17.02 0 1 4 4
Merc 240D 24.4 4 146.7 62 3.69 3.190 20.00 1 0 4 2
Camaro Z28 13.3 8 350.0 245 3.73 3.840 15.41 0 0 3 4
Cadillac Fleetwood 10.4 8 472.0 205 2.93 5.250 17.98 0 0 3 4

Again, we can also use seeds here to ensure that we’ll get the same result each time:

set.seed(123)
my_mtcars |>
slice_sample(prop = 0.5)

mpg cyl disp hp drat wt qsec vs am gear carb
Maserati Bora 15.0 8 301.0 335 3.54 3.570 14.60 0 1 5 8
Cadillac Fleetwood 10.4 8 472.0 205 2.93 5.250 17.98 0 0 3 4
Honda Civic 30.4 4 75.7 52 4.93 1.615 18.52 1 1 4 2
Merc 450SLC 15.2 8 275.8 180 3.07 3.780 18.00 0 0 3 3
Datsun 710 22.8 4 108.0 93 3.85 2.320 18.61 1 1 4 1
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Merc 280 19.2 6 167.6 123 3.92 3.440 18.30 1 0 4 4
Fiat 128 32.4 4 78.7 66 4.08 2.200 19.47 1 1 4 1
Dodge Challenger 15.5 8 318.0 150 2.76 3.520 16.87 0 0 3 2
Merc 280C 17.8 6 167.6 123 3.92 3.440 18.90 1 0 4 4
Hornet Sportabout 18.7 8 360.0 175 3.15 3.440 17.02 0 0 3 2
Toyota Corolla 33.9 4 71.1 65 4.22 1.835 19.90 1 1 4 1
Ford Pantera L 15.8 8 351.0 264 4.22 3.170 14.50 0 1 5 4
AMC Javelin 15.2 8 304.0 150 3.15 3.435 17.30 0 0 3 2
Ferrari Dino 19.7 6 145.0 175 3.62 2.770 15.50 0 1 5 6
Merc 230 22.8 4 140.8 95 3.92 3.150 22.90 1 0 4 2
Lotus Europa 30.4 4 95.1 113 3.77 1.513 16.90 1 1 5 2

INFO Exercise

Use slice_sample() to sample 32 rows from mtcars with replacement.

7.2 Statistics

The problems considered by probability and statistics are inverse to each other. In
probability theory we consider some underlying process which has some randomness
or uncertainty modeled by random variables, and we figure out what happens. In
statistics we observe something that has happened, and try to figure out what
underlying process would explain those observations. (quote attributed to Persi
Diaconis)

• In statistics we try to learn about a data-generating process (DGP) using our observed
data. Examples: surveys, GDP statistics.

• Usually we are restrained to samples, while our DGPs of interest are population-based.

– So we use random sampling or refer to superpopulations as a way to justify
how the data we observe can approximate the population.

• Statistics has two main targets:

– Estimation: how we find a reasonable guess of an unknown property (parameter)
of a DGP

– Inference: how we describe uncertainty about our estimate

• We use an estimator ̂𝜃(⋅), which is a function that summarizes data, as a guess about a
parameter 𝜃. A guess generated by an estimator in a given sample is called an estimate.
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INFO Exercise

Suppose there’s a uniform distribution 𝑋 ∼ 𝑈(0, unknown) out there.1 We want to use a
sample from this distribution (let’s say of n=30 observations) to estimate the unknown
upper bound.
Discuss: would the sample maximum be a good estimator? Why or why not?

• Theoretical statistics is all about finding “good” estimators. A few properties of good
estimators:

– Unbiasedness: Across multiple random samples, an unbiased estimator gets the
right answer on average.

– Low variance: Across multiple random samples, a low-variance estimator is more
concentrated around the true parameter.

– BUT it’s sometimes hard to get both unbiasedness and low variance. So we have
to make sacrifices. We usually quantify this via the mean squared error: 𝑀𝑆𝐸 =
𝑏𝑖𝑎𝑠2 + 𝑣𝑎𝑟𝑖𝑎𝑛𝑐𝑒. Comparing two estimators, the one with the lowest MSE is said
to be more efficient.

– Consistency: A consistent estimator converges in probability to the true value. “If
we had enough data, the probability that our estimate would be far from the truth
would be close to zero” (Aronow and Miller 2019, p. 105).

• Applied statistics is about using these techniques reasonably in messy real-world situa-
tions…

7.3 Simulations

• In simulations, we generate fake data following standard procedures. Why?

– To better understand how our estimators work in different settings (the methods
reason)

– To get insights about complex processes with many moving parts (the substantive
reason) (let’s talk about gerrymandering).

INFO Exercise

Simulate drawing an n=30 random sample from a 𝑋 ∼ 𝑈(0, 10) distribution and take its
maximum value.

1This is a fascinating distribution with a rich history, and it is used in many statistical textbooks (Whittinghill
and Hogg, 2001). It is thoroughly covered in the UT SDS Mathematical Statistics sequence.
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7.3.1 Loops

Loops allow us to repeat operations in R. The most common construct is the for-loop:

for (i in 1:10){
print(i)

}

[1] 1
[1] 2
[1] 3
[1] 4
[1] 5
[1] 6
[1] 7
[1] 8
[1] 9
[1] 10

It’s common to perform operations at each step and save the results. We typically create an
empty object and “fill it in” at each step:

results <- double(10)
for (i in 1:10){
results[i] <- i ^ 2

}

results

[1] 1 4 9 16 25 36 49 64 81 100

INFO Functional loops

Another way to do loops is with the *apply() family of functions:

sapply(1:10, function(x){x ^ 2})

[1] 1 4 9 16 25 36 49 64 81 100

We talked about loops and various extensions in one of our methods workshops last
year: Speedy R.
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7.3.2 An example simulation

We will simulate our exercise from above 10,000 times:

set.seed(1)
k <- 10000 # number of simulations
n <- 30 # number of observations in each simulation

# define an empty numeric object
simulated_estimates <- double(k)

# loop: at each step draw a random n=30 sample and get its maximum
for (i in 1:k){
random_sample <- runif(n, 0, 10)
simulated_estimates[i] <- max(random_sample)

}

Now we can analyze our simulated estimates:

mean(simulated_estimates)

[1] 9.677225

ggplot(data.frame(x = simulated_estimates), aes(x = x)) +
geom_histogram(binwidth = 0.05, boundary = 0, closed = "right")
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INFO Exercise

We just simulated to evaluate the sample maximum as an estimator. Modify the code
above to evaluate the following two estimators:

• (sample maximum) ⋅ (𝑛 + 1)
𝑛

• 2 ⋅ (sample mean)

7.3.3 Another example simulation: bootstrapping

Bootstrap (and its relatives) is one way in which we can do inference, i.e., assess uncertainty.
(We’ll go through the intuition on the board.)

# set seed an number of simulations
set.seed(1)
k <- 10000
bootstrapped_means <- double(k)
for (i in 1:k){
m <- my_mtcars |> slice_sample(prop = 1, replace = T)
bootstrapped_means[i] <- mean(m$mpg)

}
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ggplot(data.frame(bootstrapped_means), aes(x = bootstrapped_means)) +
geom_histogram(binwidth = 0.25, boundary = 0, closed = "right")
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8 Matrices

Matrices are rectangular collections of numbers. In this module we will introduce them and
review some basic operators, to then introduce a sneak peek of why matrices are useful (and
cool).

8.1 Introduction

8.1.1 Scalars

One number (for example, 12) is referred to as a scalar.

𝑎 = 12

8.1.2 Vectors

We can put several scalars together to make a vector. Here is an example:

⃗𝑏 = ⎡⎢
⎣

12
14
15

⎤⎥
⎦

Since this is a column of numbers, we cleverly refer to it as a column vector.

Here is another example of a vector, this time represented as a row vector :

⃗𝑐 = [12 14 15]

Column vectors are possibly more common and useful, but we sometimes write things down
using row vectors to

Vectors are fairly easy to construct in R. As we saw before, we can use the c() function to
combine elements:
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c(5, 25, -2, 1)

[1] 5 25 -2 1

Exclamation-Triangle Warning

Remember that the code above does not create any objects. To do so, you’d need to use
the assignment operator (<-):

vector_example <- c(5, 25, -2, 1)
vector_example

[1] 5 25 -2 1

Or we can also create vectors from sequences with the : operator or the seq() function:

10:20

[1] 10 11 12 13 14 15 16 17 18 19 20

seq(from = 3, to = 27, by = 3)

[1] 3 6 9 12 15 18 21 24 27

8.2 Operators

8.2.1 Summation

The summation operator ∑ (i.e., the uppercase Sigma letter) lets us perform an operation on
a sequence of numbers, which is often but not always a vector.

⃗𝑑 = [12 7 −2 3 −1]

We can then calculate the sum of the first three elements of the vector, which is expressed as
follows:

3
∑
𝑖=1

𝑑𝑖
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Then we do the following math:
12 + 7 + (−2) = 17

It is also common to use 𝑛 in the superscript to indicate that we want to sum all elements:

𝑛
∑
𝑖=1

𝑑𝑖 = 12 + 7 + (−2) + 3 + (−1) = 19

We can perform these operations using the sum() function in R:

vector_d <- c(12, 7, -2, 3, -1)

sum(vector_d[1:3])

[1] 17

sum(vector_d)

[1] 19

8.2.2 Product

The product operator ∏ (i.e., the uppercase Pi letter) can also perform operations over a
sequence of elements in a vector. Recall our previous vector:

⃗𝑑 = [12 7 −2 3 1]

We might want to calculate the product of all its elements, which is expressed as follows:
𝑛
∏
𝑖=1

𝑑𝑖 = 12 ⋅ 7 ⋅ (−2) ⋅ 3 ⋅ (−1) = 504

In R, we can compute products using the prod() function:

prod(vector_d)

[1] 504
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INFO Exercise

Get the product of the first three elements of vector 𝑑. Write the notation by hand and
use R to obtain the number.

8.3 Matrices

8.3.1 Basics

We can append vectors together to form a matrix:

𝐴 = ⎡⎢
⎣

12 14 15
115 22 127
193 29 219

⎤⎥
⎦

The number of rows and columns of a matrix constitute the dimensions of the matrix. The
first number is the number of rows (“r”) and the second number is the number of columns (“c”)
in the matrix.

Exclamation Important

Find a way to remember “r x c” permanently. The order of the dimensions never changes.

Matrix 𝐴 above, for example, is a 3 × 3 matrix. Sometimes we’d refer to it as 𝐴3×3.

LIGHTBULB Tip

It is common to use capital letters (sometimes bold-faced) to represent matrices. In
contrast, vectors are usually represented with either bold lowercase letters or lowercase
letters with an arrow on top (e.g., ⃗𝑣).

Constructing matrices in R

There are different ways to create matrices in R. One of the simplest is via rbind() or cbind(),
which paste vectors together (either by rows or by columns):

# Create some vectors
vector1 <- 1:4
vector2 <- 5:8
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vector3 <- 9:12
vector4 <- 13:16

# Using rbind(), each vector will be a row
rbind_mat <- rbind(vector1, vector2, vector3, vector4)
rbind_mat

[,1] [,2] [,3] [,4]
vector1 1 2 3 4
vector2 5 6 7 8
vector3 9 10 11 12
vector4 13 14 15 16

# Using cbind(), each vector will be a column
cbind_mat <- cbind(vector1, vector2, vector3, vector4)
cbind_mat

vector1 vector2 vector3 vector4
[1,] 1 5 9 13
[2,] 2 6 10 14
[3,] 3 7 11 15
[4,] 4 8 12 16

An alternative is to use to properly named matrix() function. The basic syntax is
matrix(data, nrow, ncol, byrow):

• data is the input vector which becomes the data elements of the matrix.
• nrow is the number of rows to be created.
• ncol is the number of columns to be created.
• byrow is a logical clue. If TRUE then the input vector elements are arranged by row. By

default (FALSE), elements are arranged by column.

Let’s see some examples:

# Elements are arranged sequentially by row.
M <- matrix(c(1:12), nrow = 4, byrow = T)
M

[,1] [,2] [,3]
[1,] 1 2 3
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[2,] 4 5 6
[3,] 7 8 9
[4,] 10 11 12

# Elements are arranged sequentially by column (byrow = F by default).
N <- matrix(c(1:12), nrow = 4)
N

[,1] [,2] [,3]
[1,] 1 5 9
[2,] 2 6 10
[3,] 3 7 11
[4,] 4 8 12

8.3.2 Structure

How do we refer to specific elements of the matrix? For example, matrix 𝐴 is an 𝑚×𝑛 matrix
where 𝑚 = 𝑛 = 3. This is sometimes called a square matrix.

More generally, matrix 𝐵 is an 𝑚× 𝑛 matrix where the elements look like this:

𝐵 =
⎡
⎢
⎢
⎣

𝑏11 𝑏12 𝑏13 … 𝑏1𝑛
𝑏21 𝑏22 𝑏23 … 𝑏2𝑛
⋮ ⋮ ⋮ … ⋮

𝑏𝑚1 𝑏𝑚2 𝑏𝑚3 … 𝑏𝑚𝑛

⎤
⎥
⎥
⎦

Thus 𝑏23 refers to the second unit down and third across. More generally, we refer to row
indices as 𝑖 and to column indices as 𝑗.

In R, we can access a matrix’s elements using square brackets:

# In matrix N, access the element at 1st row and 3rd column.
N[1,3]

[1] 9

# In matrix N, access the element at 4th row and 2nd column.
N[4,2]

[1] 8
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LIGHTBULB Tip

When trying to identify a specific element, the first subscript is the element’s row and the
second subscript is the element’s column (always in that order).

Exclamation-Triangle Warning

In R, indexing is 1-based, meaning that the first element of a vector, matrix, or any other
data structure is accessed with index 1. In other programming tools such as Python,
indexing is 0-based, meaning that the first element of a list, array, or any other data
structure is accessed with index 0.

# Create a 2x2 matrix in R
matrix_A <- matrix(1:4, nrow = 2, ncol = 2)

# Access the element in the first row, first column
element <- matrix_A[1, 1] # This will return 1

# Create a list in Python
vector = [10, 20, 30, 40]

# Access the first element
first_element = vector[0] # This will return 10
import numpy as np

# Create a 2x2 matrix in Python with NumPy
matrix_A = np.array([[1, 2], [3, 4]])

# Access the element in the first row, first column
element = matrix_A[0, 0] # This will return 1

8.4 Matrix operations

8.4.1 Addition and subtraction

• Addition and subtraction are straightforward operations.

• Matrices must have exactly the same dimensions for both of these operations.

• We add or subtract each element with the corresponding element from the other matrix.
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• This is expressed as follows:

𝐴±𝐵 = 𝐶

𝑐𝑖𝑗 = 𝑎𝑖𝑗 ± 𝑏𝑖𝑗 ∀𝑖, 𝑗

⎡⎢
⎣

𝑎11 𝑎12 𝑎13
𝑎21 𝑎22 𝑎23
𝑎31 𝑎32 𝑎33

⎤⎥
⎦
± ⎡⎢

⎣

𝑏11 𝑏12 𝑏13
𝑏21 𝑏22 𝑏23
𝑏31 𝑏32 𝑏33

⎤⎥
⎦

=

⎡⎢
⎣

𝑎11 ± 𝑏11 𝑎12 ± 𝑏12 𝑎13 ± 𝑏13
𝑎21 ± 𝑏21 𝑎22 ± 𝑏22 𝑎23 ± 𝑏23
𝑎31 ± 𝑏31 𝑎32 ± 𝑏32 𝑎33 ± 𝑏33

⎤⎥
⎦

Addition and subtraction in R

We start by creating two 2x3 matrices:

𝐴 = [3 −1 2
9 4 6]

# Create two 2x3 matrices.
matrix1 <- matrix(c(3, 9, -1, 4, 2, 6), nrow = 2)
matrix1

[,1] [,2] [,3]
[1,] 3 -1 2
[2,] 9 4 6

And
𝐵 = [5 2 0

9 3 4]

matrix2 <- matrix(c(5, 2, 0, 9, 3, 4), nrow = 2)
matrix2

[,1] [,2] [,3]
[1,] 5 0 3
[2,] 2 9 4
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We can simply use the + and - operators for addition and substraction:

matrix1 + matrix2

[,1] [,2] [,3]
[1,] 8 -1 5
[2,] 11 13 10

matrix1 - matrix2

[,1] [,2] [,3]
[1,] -2 -1 -1
[2,] 7 -5 2

INFO Exercise

(Use code for one of these and do the other one by hand!)
1) Calculate 𝐴+𝐵

𝐴 = [ 1 0
−2 −1]

𝐵 = [5 1
2 −1]

2) Calculate 𝐴−𝐵

𝐴 = [6 −2 8 12
4 42 8 −6]

𝐵 = [18 42 3 7
0 −42 15 4]

8.4.2 Scalar multiplication

Scalar multiplication is very intuitive. As we know, a scalar is a single number. We multiply
each value in the matrix by the scalar to perform this operation.
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Formally, this is expressed as follows:

𝐴 = ⎡⎢
⎣

𝑎11 𝑎12 𝑎13
𝑎21 𝑎22 𝑎23
𝑎31 𝑎32 𝑎33

⎤⎥
⎦

𝑐𝐴 = ⎡⎢
⎣

𝑐𝑎11 𝑐𝑎12 𝑐𝑎13
𝑐𝑎21 𝑐𝑎22 𝑐𝑎23
𝑐𝑎31 𝑐𝑎32 𝑐𝑎33

⎤⎥
⎦

In R, all we need to do is take an established matrix and multiply it by some scalar:

# matrix1 from our previous example
matrix1

[,1] [,2] [,3]
[1,] 3 -1 2
[2,] 9 4 6

matrix1 * 3

[,1] [,2] [,3]
[1,] 9 -3 6
[2,] 27 12 18

INFO Exercise

Calculate 2 × 𝐴 and −3 × 𝐵. Again, do one by hand and the other one using R.

𝐴 = [1 4 8
0 −1 3]

𝐵 = ⎡⎢
⎣

−15 1 5
2 −42 0
7 1 6

⎤⎥
⎦

8.4.3 Matrix multiplication

• Multiplying matrices is slightly trickier than multiplying scalars.

• Two matrices must be conformable for them to be multiplied together. This means that
the number of columns in the first matrix equals the number of rows in the second.

• When multiplying 𝐴×𝐵, if 𝐴 is 𝑚× 𝑛, 𝐵 must have 𝑛 rows.
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Exclamation Important

The conformability requirement never changes. Before multiplying anything, check to
make sure the matrices are indeed conformable.

• The resulting matrix will have the same number of rows as the first matrix and the
number of columns in the second. For example, if 𝐴 is 𝑖 × 𝑘 and 𝐵 is 𝑘 × 𝑗, then 𝐴×𝐵
will be 𝑖 × 𝑗.

Which of the following can we multiply? What will be the dimensions of the resulting matrix?

𝐵4×1 =
⎡
⎢
⎢
⎣

2
3
4
1

⎤
⎥
⎥
⎦

𝑀3×3 = ⎡⎢
⎣

1 0 2
1 2 4
2 3 2

⎤⎥
⎦
𝐿2×3 = [6 5 −1

1 4 3 ]

The only valid multiplication based on the provided matrices is 𝐿×𝑀, which results in a 2× 3
matrix.

Why can’t we multiply in the opposite order?

The non-commutative property of matrix multiplication is a fundamental aspect in matrix
algebra. The multiplication of matrices is sensitive to the order in which the matrices are
multiplied due to the requirements of dimensional compatibility, the resulting dimensions, and
the computation process itself.

Exclamation-Triangle Warning

When multiplying matrices, order matters. Even if multiplication is possible in both
directions, in general 𝐴𝐵 ≠ 𝐵𝐴.

Multiplication steps

• Multiply each row by each column, summing up each pair of multiplied terms.

LIGHTBULB Tip

This is sometimes to referred to as the “dot product,” where we multiply matching
members, then sum up.
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• The element in position 𝑖𝑗 is the sum of the products of elements in the 𝑖th row of the
first matrix (𝐴) and the corresponding elements in the 𝑗th column of the second matrix
(𝐵).

𝑐𝑖𝑗 =
𝑛

∑
𝑘=1

𝑎𝑖𝑘𝑏𝑘𝑗

Example

Suppose a company manufactures two kinds of furniture: chairs and sofas.

• A chair costs $100 for wood, $270 for cloth, and $130 for feathers.

• Each sofa costs $150 for wood, $420 for cloth, and $195 for feathers.

Chair Sofa

Wood 100 150
Cloth 270 420
Feathers 130 195

The same information about unit cost (𝐶) can be presented as a matrix.

𝐶 = ⎡⎢
⎣

100 150
270 420
130 195

⎤⎥
⎦

Note that each of the three rows of this 3 x 2 matrix represents a material (wood, cloth, or
feathers), and each of the two columns represents a product (chair or coach). The elements are
the unit cost (in USD).

Now, suppose that the company will produce 45 chairs and 30 sofas this month. This production
quantity can be represented in the following table, and also as a 2 x 1 matrix (𝑄):

Product Quantity

Chair 45
Sofa 30
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𝑄 = [4530]

What will be the company’s total cost? The “total expenditure” is equal to the “unit cost”
times the “production quantity” (the number of units).

The total expenditure (𝐸) for each material this month is calculated by multiplying these two
matrices.

𝐸 = 𝐶𝑄 = ⎡⎢
⎣

100 150
270 420
130 195

⎤⎥
⎦
[4530] = ⎡⎢

⎣

(100)(45) + (150)(30)
(270)(45) + (420)(30)
(130)(45) + (195)(30)

⎤⎥
⎦

= ⎡⎢
⎣

9, 000
24, 750
11, 700

⎤⎥
⎦

Multiplying the 3x2 Cost matrix (𝐶) times the 2x1 Quantity matrix (𝑄) yields the 3x1
Expenditure matrix (𝐸).

As a result of this matrix multiplication, we determine that this month the company will incur
expenditures of:

• $9,000 for wood
• $24,750 for cloth
• $11,700 for feathers.

Matrix multiplication in R

Before attempting matrix multiplication, we must make sure the matrices are conformable (as
we do for our manual calculations).

Then we can multiply our matrices together using the %*% operator.

C <- matrix(c(100, 270, 130, 150, 420, 195), nrow = 3)
C

[,1] [,2]
[1,] 100 150
[2,] 270 420
[3,] 130 195

Q <- matrix(c(45, 30), nrow = 2)
Q
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[,1]
[1,] 45
[2,] 30

C %*% Q

[,1]
[1,] 9000
[2,] 24750
[3,] 11700

Exclamation-Triangle Warning

If you have a missing value or NA in one of the matrices you are trying to multiply
(something we will discuss in further detail in the next module), you will have NAs in your
resulting matrix.

8.4.4 Properties of operations

• Addition and subtraction:

– Associative: (𝐴 ± 𝐵) ± 𝐶 = 𝐴± (𝐵 ± 𝐶)

– Communicative: 𝐴±𝐵 = 𝐵 ±𝐴

• Multiplication:

– 𝐴𝐵 ≠ 𝐵𝐴

– 𝐴(𝐵𝐶) = (𝐴𝐵)𝐶

– 𝐴(𝐵 + 𝐶) = 𝐴𝐵 +𝐴𝐶

– (𝐴 + 𝐵)𝐶 = 𝐴𝐶 +𝐵𝐶
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8.5 Special matrices

Square matrix

𝐴 = ⎡⎢
⎣

1 2 3
4 5 6
7 8 9

⎤⎥
⎦

• In a square matrix, the number of rows equals the number of columns (𝑚 = 𝑛):

• The diagonal of a matrix is a set of numbers consisting of the elements on the line from
the upper-left-hand to the lower-right-hand corner of the matrix, as in $ d(A)=[1,5,9] $.
Diagonals are particularly useful in square matrices.

• The trace of a matrix, denoted as 𝑡𝑟(𝐴), is the sum of the diagonal elements of the matrix.
𝑡𝑟(𝐴) = 1 + 5 + 9 = 15

Diagonal matrix:

• In a diagonal matrix, all of the elements of the matrix that are not on the diagonal are
equal to zero.

𝐷 = ⎡⎢
⎣

4 0 0
0 5 0
0 0 6

⎤⎥
⎦

Scalar matrix:

• A scalar matrix is a diagonal matrix where the diagonal elements are all equal to each
other. In other words, we’re really only concerned with one scalar (or element) held in
the diagonal.

𝑆 = ⎡⎢
⎣

7 0 0
0 7 0
0 0 7

⎤⎥
⎦

Identity matrix:

𝐼 = ⎡⎢
⎣

1 0 0
0 1 0
0 0 1

⎤⎥
⎦

• The identity matrix is a scalar matrix with all of the diagonal elements equal to one.

• Remember that, as with all diagonal matrices, the off-diagonal elements are equal to zero.
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• The capital letter 𝐼 is reserved for the identity matrix. For convenience, a 3x3 identity
matrix can be denoted as 𝐼3.

8.6 Transpose

The transpose is the original matrix with the rows and the columns interchanged.

The notation is either 𝐽 ′ (“J prime”) or 𝐽𝑇 (“J transpose”).

𝐽 = ⎡⎢
⎣

4 5
3 0
7 −2

⎤⎥
⎦

𝐽 ′ = 𝐽𝑇 = [4 3 7
5 0 −2]

In R, we use t() to get the transpose.

J <- matrix(c(4, 3, 7, 5, 0, -2), ncol = 2)
J

[,1] [,2]
[1,] 4 5
[2,] 3 0
[3,] 7 -2

t(J)

[,1] [,2] [,3]
[1,] 4 3 7
[2,] 5 0 -2

8.7 Inverse

• Just like a number has a reciprocal, a matrix has an inverse.

• When we multiply a matrix by its inverse we get the identity matrix (which is like “1”
for matrices).
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𝐴×𝐴−1 = 𝐼

• The inverse of A is 𝐴−1 only when:

𝐴𝐴−1 = 𝐴−1𝐴 = 𝐼

• Sometimes there is no inverse at all.

INFO Note

For now, don’t worry about calculating the inverse of a matrix manually. This is the type
of task we use R for.

• In R, we use the solve() function to calculate the inverse of a matrix:

A <- matrix(c(3, 2, 5, 2, 3, 2, 5, 2, 4), ncol = 3)
A

[,1] [,2] [,3]
[1,] 3 2 5
[2,] 2 3 2
[3,] 5 2 4

solve(A)

[,1] [,2] [,3]
[1,] -0.29629630 -0.07407407 0.4074074
[2,] -0.07407407 0.48148148 -0.1481481
[3,] 0.40740741 -0.14814815 -0.1851852

8.8 Linear systems and matrices

• A system of equations can be represented by an augmented matrix.

• System of equations:
3𝑥 + 6𝑦 = 12

5𝑥 + 10𝑦 = 25
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• In an augmented matrix, each row represents one equation in the system and each column
represents a variable or the constant terms.

[3 6 12
5 10 25]

8.9 OLS and matrices

• We can use the logic above to calculate estimates for our ordinary least squares (OLS)
models.

• OLS is a linear regression technique used to find the best-fitting line for a set of data
points (observations) by minimizing the residuals (the differences between the observed
and predicted values).

• We minimize the sum of the squared errors.

8.9.1 Dependent variable

• Suppose, for example, we have a sample consisting of 𝑛 observations.

• The dependent variable is denoted as an 𝑛 × 1 column vector.

𝑌 =
⎡
⎢
⎢
⎢
⎣

𝑦1
𝑦2
𝑦3
⋮
𝑦𝑛

⎤
⎥
⎥
⎥
⎦

8.9.2 Independent variables

• Suppose there are 𝑘 independent variables and a constant term, meaning 𝑘 + 1 columns
and 𝑛 rows.

• We can represent these variables as an 𝑛 × (𝑘 + 1) matrix, expressed as follows:

𝑋 =
⎡
⎢
⎢
⎣

1 𝑥11 … 𝑥1𝑘
1 𝑥21 … 𝑥2𝑘
⋮ ⋮ … ⋮
1 𝑥𝑛1 … 𝑥𝑛𝑘

⎤
⎥
⎥
⎦

• 𝑥𝑖𝑗 is the 𝑖-th observation of the 𝑗-th independent variable.
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8.9.3 Linear regression model

• Let’s say we have 173 observations (n = 173) and 2 IVs (k = 3).

• This can be expressed as the following linear equation:

𝑦 = 𝛽0 + 𝛽1𝑥1 + 𝛽2𝑥2 + 𝜖

• In matrix form, we have:

⎡
⎢
⎢
⎣

𝑦1
𝑦2
⋮
𝑦𝑛

⎤
⎥
⎥
⎦

=
⎡
⎢
⎢
⎣

1 𝑥11 𝑥21
1 𝑥21 𝑥22
⋮ ⋮ ⋮
1 𝑥1173 𝑥2173

⎤
⎥
⎥
⎦

⎡⎢
⎣

𝛽0
𝛽1
𝛽2

⎤⎥
⎦
+

⎡
⎢
⎢
⎣

𝜖1
𝜖2
⋮

𝜖173

⎤
⎥
⎥
⎦

• All 173 equations can be represented by:

𝑦 = 𝑋𝛽 + 𝜖

8.9.4 Estimates

• Without getting too much into the mechanics, we can calculate our coefficient estimates
with matrix algebra using the following equation:

̂𝛽 = (𝑋′𝑋)−1𝑋′𝑌

• Read aloud, we say “X prime X inverse, X prime Y”.

• The little hat on our beta ( ̂𝛽) signifies that these are estimates.

• Remember, the OLS method is to choose ̂𝛽 such that the sum of squared residuals (“SSR”)
is minimized.

8.9.4.1 Example in R

• We will load the mtcars data set (our favorite) for this example, which contains data
about many different car models.

cars_df <- mtcars

• Now, we want to estimate the association between hp (horsepower) and wt (weight), our
independent variables, and mpg (miles per gallon), our dependent variable.
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• First, we transform our dependent variable into a matrix, using the as.matrix function
and specifying the column of the mtcars data set to create a column vector of our
observed values for the DV.

Y <- as.matrix(cars_df$mpg)
Y

[,1]
[1,] 21.0
[2,] 21.0
[3,] 22.8
[4,] 21.4
[5,] 18.7
[6,] 18.1
[7,] 14.3
[8,] 24.4
[9,] 22.8
[10,] 19.2
[11,] 17.8
[12,] 16.4
[13,] 17.3
[14,] 15.2
[15,] 10.4
[16,] 10.4
[17,] 14.7
[18,] 32.4
[19,] 30.4
[20,] 33.9
[21,] 21.5
[22,] 15.5
[23,] 15.2
[24,] 13.3
[25,] 19.2
[26,] 27.3
[27,] 26.0
[28,] 30.4
[29,] 15.8
[30,] 19.7
[31,] 15.0
[32,] 21.4

• Next, we do the same thing for our independent variables of interest, and our constant.
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# create two separate matrices for IVs
X1 <- as.matrix(cars_df$hp)
X2 <- as.matrix(cars_df$wt)

# create constant column

# bind them altogether into one matrix
constant <- rep(1, nrow(cars_df))
X <- cbind(constant, X1, X2)
X

constant
[1,] 1 110 2.620
[2,] 1 110 2.875
[3,] 1 93 2.320
[4,] 1 110 3.215
[5,] 1 175 3.440
[6,] 1 105 3.460
[7,] 1 245 3.570
[8,] 1 62 3.190
[9,] 1 95 3.150
[10,] 1 123 3.440
[11,] 1 123 3.440
[12,] 1 180 4.070
[13,] 1 180 3.730
[14,] 1 180 3.780
[15,] 1 205 5.250
[16,] 1 215 5.424
[17,] 1 230 5.345
[18,] 1 66 2.200
[19,] 1 52 1.615
[20,] 1 65 1.835
[21,] 1 97 2.465
[22,] 1 150 3.520
[23,] 1 150 3.435
[24,] 1 245 3.840
[25,] 1 175 3.845
[26,] 1 66 1.935
[27,] 1 91 2.140
[28,] 1 113 1.513
[29,] 1 264 3.170
[30,] 1 175 2.770
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[31,] 1 335 3.570
[32,] 1 109 2.780

• Next, we calculate 𝑋′𝑋, 𝑋′𝑌, and (𝑋′𝑋)−1.

Don’t forget to use %*% for matrix multiplication!

# X prime X
XpX <- t(X) %*% X

# X prime X inverse
XpXinv <- solve(XpX)

# X prime Y
XpY <- t(X) %*% Y

# beta coefficient estimates
bhat <- XpXinv %*% XpY
bhat

[,1]
constant 37.22727012

-0.03177295
-3.87783074
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9 Wrap-up

9.1 Project management

9.1.1 RStudio projects

• RStudio projects are an excellent way to keep all the files associated with a project (data,
R scripts, results, figures, etc.) in one place on your computer.

• This is one of the best ways to improve your workflow in RStudio, allowing you to:

– Create a project for each paper or data analysis project.
– Store data files in one place.
– Save, edit, and run scripts.
– Keep outputs such as plots and cleaned data.

• To create a new project file, click File > New Project, then:
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• Call your project some version of “methodscamptest” and choose carefully where you
wish to store the project on your machine.

Exclamation-Triangle Warning

If you don’t store your project (and your other files, too!) somewhere reasonable, it will
be hard to find it in the future! We recommend creating a clear organizational scheme for
yourself early on.
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9.1.1.1 Using RStudio projects

When using an RStudio project, you should see its name in the top-right corner of RStudio,
next to a light blue icon. You can check with R the folder in which your project operates:

getwd()

• Now, as an example, let’s run the following commands in the script editor and save the
files into the project directory.

library(tidyverse)

my_plot <- ggplot(mtcars, aes(wt, mpg)) +
geom_point()

ggsave(plot = my_plot,
filename = "plot_mtcars.pdf")

write_csv(mtcars, "mtcars.csv")

• Quit RStudio and check out the folder associated with the project.

• You should see the PDF file for the plot, the .csv file for the data, and the .Rproj file for
the project itself.

• Double-click the .Rproj file to reopen the project and pick up where you left off!
Everything you need should be ready to go.

9.2 Quarto documents and R Scripts

We have worked with .qmd scripts during Methods Camp. Quarto is a very flexible format that
allows code, math, and text. People use it to make reports (PDF or HTML), presentations,
websites, etc. You can create a Quarto document from RStudio using File > New File >
Quarto Document, and then compile it to its final form using the “Render” button.

You should also be aware of regular R scripts, with a .R extension. They can be created in
RStudio using File > New File > R Script. They just allow code: to add comments, you
need to preface them by the pound sign (#).
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9.3 Other software resources

9.3.1 Overleaf

• Overleaf is a collaborative cloud-based LaTeX editor designed for writing, editing, and
publishing documents.

– LaTeX is a software used for typesetting technical documents. It is used widely in
our discipline for the preparation for manuscripts to journals and other publishing
venues.

• UT Austin actually provides free access to Overleaf Professional to graduate students
using your UT email. (The Professional accounts allows more collaborators on projects
and other goodies.)

INFO Exercise

Create an Overleaf Professional account using your UT email address. You can do so
here.

Exclamation Important

̂𝛽 = (𝑋′𝑋)−1𝑋′𝑌

LaTeX is actually the markup language that the math in Quarto and this website! If you
are curious about general syntax and commands, you can access our repository at any
time to get a closer look.
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9.3.2 Zotero

• Zotero is an open-source reference manager used to store, manage, and cite bibliographic
references, such as books and articles.

• When it is time to write, you can insert your sources directly into your paper as in-text
citations via a word processor plugin, which generates a bibliography in your style of
choice (e.g., APA). It works with Word, Google Docs, Overleaf, and RStudio.

– This can save a lot of time, especially when you have to change citation styles for
submission to another journal.

• You can download the software for free here.

INFO Note

Zotero is one of many other reference managers out there. Alternatives include Mendeley
and EndNote, among others. You should choose whatever option best suits your needs.

Exclamation-Triangle Consume AI wisely!

• GPT can help with programming, but you must have domain knowledge.
• Interactions with ChatGPT are not exactly repeatable.
• GPT can help with expediting search from Google or Stack Overflow for trou-

bleshooting, but it is not always correct.
• Read GPT’s explanation carefully to make sure it does what you want. It is a tool

to help you learn, not to do the work for you!
• Try to type out the generated code yourself, do NOT copy and paste
• In your problem sets, always acknowledge that you have consulted AI for support.

• When errors occur, copy the error messages and paste them into GPT for trou-
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bleshooting.
• You can continue with follow-up instructions to improve the results.
• In case of a catch-22 situation, use your domain expertise.

9.4 Methods at UT

9.4.1 Required methods courses

• Scope and Methods of Political Science

• Statistics I (Statistics/linear regression)

• Statistics II (Linear regression and more)

• Statistics III (Maximum likelihood estimation)

– Only required if your major field is methods

9.4.2 Other methods courses

• Statistics / Econometrics / Machine Learning:

– Causal Inference
– Bayesian Statistics
– Math Methods for Political Analysis
– Time Series and Panel Data
– Panel and Multilevel Analysis
– Network Analysis
– Machine Learning in Political Science
– Making Big Data

• Formal Theory

– Intro to Formal Political Analysis
– Formal Political Analysis II
– Formal Theories of International Relations

• Everything else

– Conceptualization and Measurement
– Experimental Methods in Political Science
– Qualitative Methods
– Seminar in Field Experiments

162



9.4.3 Other departments at UT

You can also take courses through the Economics, Business (IROM), Sociology, Mathematics,
or Statistics (SDS) departments.

• M.S. in Statistics

• Software and Topic Short Courses at SDS (see their Events page): R, Python, Stata, etc.

9.4.4 Methods Fellow

The Methods Fellow is a grad student who serves as a Methods TA for all other UT Gov grad
students.

• Holds office hours
• Hosts a Methods Co-Working Hour
• Organizes workshops

9.4.5 Methods summer programs

• ICPSR (Inter-university Consortium for Political and Social Research)

– Ann Arbor, Michigan

• IQMR (Institute for Qualitative and Multi-Method Research)

– Syracuse, NY

• EITM (Empirical Implications of Theoretical Models)

– Various locations

9.4.6 More methods camps!

• UT Methods Camp Website

– Check out the PDF download!

• Harvard Math Prefresher

• Northwestern Math Camp (2022)

• Duke Math Camp (2019)

– Make sure to follow the links for the videos, etc.
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